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法律声明

担保。 

随 HP 产品及服务提供的明示性担保声明中列出了适用于此 HP 产品及服务的

专用担保条款。 本文中的任何内容均不构成额外的担保。 HP 对本文中的技术

或编辑错误以及缺漏不负任何责任。

本文档中的信息如有更改，恕不另行通知。

有限权利声明。 

机密计算机软件。 必须有 HP 授予的有效许可证，方可拥有、使用或复制本软

件。根据供应商的标准商业许可证的规定，美国政府应遵守 FAR 12.211 和

12.212 中有关“商业计算机软件”、“计算机软件文档”与“商业货物技术

数据”条款的规定。

版权声明。 

©版权所有 1983-2006 Hewlett-Packard Development Company, L.P.

在未获得 Hewlett-Packard Company 的书面许可前，本文档的任何部分不得翻

印、重新制作或翻译成另一种语言。 本文档中的信息如有更改，恕不另行通知。

商标声明。

Adobe® 和 Acrobat® 是 Adobe Systems Incorporated 的商标。 

所有 HP 9000 计算机上的 HP-UX 10.20 及更高版本和 HP-UX 11.00 及更高版

本（同时具有 32 位和 64 位配置）都是 Open Group UNIX 95 的系列产品。

Java™ 和所有基于 Java 的商标和徽标是 Sun Microsystems, Inc. 在美国及其他

国家和地区的商标或注册商标。

Microsoft® 是 Microsoft Corporation 在美国的注册商标。

OpenView® 是 Hewlett-Packard Company 在美国的注册商标。

Oracle® 是 Oracle Corporation (Redwood City, California) 在美国的注册商标。

UNIX® 是 Open Group 的注册商标。 

Windows NT® 是 Microsoft Corporation 在美国的注册商标。

Windows® 和 MS Windows® 是 Microsoft Corporation 在美国的注册商标。

Windows XP® 是 Microsoft Corporation 在美国的注册商标。

所有其它产品名称均是其各自商标或服务标志所有者的财产，特此声明。
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文档更新

本手册的标题页包含以下标识信息：

• 版本号，指明软件版本。

• 文档发行日期，每次更新文档时该日期将随之更改。

• 软件发行日期，指明此版本软件的发行日期。

要检查最新更新或验证使用的版本是否是最新版本，请访问以下 URL：

http://ovweb.external.hp.com/lpe/doc_serv/

如果订阅了适当的产品支持服务，您还会收到更新版本或新版本。有关详细

信息，请与您的 HP 销售代表联系。
  9
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技术支持

请访问以下 HP OpenView 技术支持网站：

http://www.hp.com/managementsoftware/support

本网站提供了联系信息以及与 HP OpenView 提供的产品、服务和技术支持有关

的详细信息。

HP OpenView 联机软件技术支持提供了客户自助功能。 客户自助功能是一种

快捷有效的方法，可用于访问管理业务所需的交互式技术支持工具。作为重要

的技术支持客户，您可以通过以下方式使用该网站并从中受益：

• 搜索感兴趣的知识文档

• 联机提交改进请求

• 下载软件补丁程序

• 提交技术支持案例并跟踪其进度

• 管理技术支持合同

• 查找 HP 技术支持联系人

• 查看有关可用服务的信息

• 与其他软件客户进行讨论

• 了解软件培训内容并注册

大多数支持区域要求注册成为 HP Passport 用户并登录。很多技术支持区域还

要求具备技术支持合同。

要查找有关访问级别的更多信息，请转至：

http://www.hp.com/managementsoftware/access_level

要注册 HP Passport ID，请转至： 

http://www.managementsoftware.hp.com/passport-registration.html
  11
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第 1 章 概述

本章概述 Service Level Manager 功能。通过这些功能，SLM 员工可以监视服务，

并针对遵守受管服务级别协议的服务生成 SLM 报告。
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什么是 Service Level Manager？
什么是 Service Level Manager？

Service Level Manager 提供了一个可以使组织采用服务级别管理流程的功能集。

在这些流程中，基于指标适配器从服务监视应用程序收集到的指标数据值，

对按照事先约定的服务级别向客户提供的服务进行监视和评估，以查看其符

合性。

在使用 Service Level Manager 的组织中，将执行以下活动： 

• SLM 管理员安装、配置和维护 Service Level Manager 所需的组件。

• 服务设计人员创建可重用服务定义，其中包括规范的指标和目标。

• 服务经理基于服务定义或层次过滤器创建受监视服务。服务层次包含表示

IT 基础结构元素用于向客户提供服务的所有配置项及附属服务。

• SLM 员工监视服务的当前符合性状态、在当前评估期结束时预测服务达

到的符合性状态、服务的当前可用性以及需要注意的配置项。

• SLM 员工对由可用性和符合性状态更改自动触发的警报事故做出响应。

• SLM 员工打印评估报告或联机查看上一个评估期或当前进行中的评估期。

• 服务用户检查要使用的服务的当前可用性。
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Service Level Manager 功能
Service Level Manager 功能

本节概述主要功能。

附加对象和扩展

Service Level Manager 为诸如服务、服务定义和配置项 (CI) 的基本对象提供

了扩展，也为附加对象提供了扩展，如指标适配器、层次过滤器和服务级别

目标。

通过附加对象和扩展，可以为向客户提供的服务指定以下信息：

• 确定测量服务层次中每个配置项可用性的方法的指标和目标

• 确定测量每项服务符合性的方法的指标和目标

• 有关监视应用程序、管理服务器和指标适配器（它们一起测量配置项的性

能并为计算并报告可用性和符合性提供测量结果）的详细信息

可用性和符合性的计算结果会自动显示在表单和视图中。通过这些表单和

视图，用户可以在整个当前评估期内连续监视可用性和符合性。

服务设计功能

服务设计人员可以为可重用的服务定义指定指标和目标。每当服务经理基于

特定服务定义创建受监视服务时，服务层次中的每个配置项将自动从其所基

于的定义中继承指标和目标。如果要根据所选择的服务级别来提供服务，则服

务定义可以按渐进方式为每个较高的服务级别提供更高要求的目标。

Service Level Manager 提供了服务设计功能，这些功能简化了建立复杂服务定义

层次的任务以及指定指标和目标的任务。
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Service Level Manager 功能
您可以使用图形视图来创建服务定义层次，该视图显示是否完全定义了层次

中对象的指标和目标。图 1-1 显示了服务定义层次的示例。

图 1-1 服务定义层次示例

基于服务定义创建的受监视服务也可以通过图形方式显示，以便确认是否已

完全指定了层次中的对象。
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Service Level Manager 功能
服务建模功能

在始终将其配置管理数据库 (CMDB) 连同配置项之间的关系以及配置项类别

一起进行更新的组织中，服务设计人员可以利用层次过滤器。基于特定层次过

滤器的服务将自动继承由该过滤器定义的服务层次。

服务建模功能简化了创建层次过滤器的任务。通过交互式图形用户界面，您可

以添加、修改和删除过滤器规则，这些过滤器规则可以确定在服务层次中包括

的 CMDB 元素。图形预览窗口将根据特定基本对象和当前包括的过滤器规则

来显示服务层次。

您可以通过指定叶节点来调整服务层次。叶节点是在服务层次中没有附属元

素的元素。通过调整服务层次，可以将配置项从可用性和符合性计算中排除，

但不会将它们从 CMDB 中删除。非必不可少的备份服务器便是这类配置项的

一个示例。图 1-2 给出了层次过滤器的示例。

图 1-2 层次过滤器示例
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Service Level Manager 功能
可用性和符合性计算

Service Level Manager 将在服务级别协议的每个评估期内反复执行可用性和符合

性状态计算。每当接收到已安装的指标适配器所提供的指标数据值时，便会触

发这种计算。

Service Level Manager 将计算以下项：

• 服务级别协议和服务的符合性状态

• 从目前到当前评估期结束这段时间内，所计划的服务级别协议和服务的预

测符合性状态

• 服务和配置项的当前可用性

可用性和符合性警报

可以设置警报，自动通知 SLM 员工影响服务级别协议、服务和配置项的可用

性和符合性状态发生了更改。

每当计算得出的对象的可用性或符合性状态发生更改时，系统将自动创建属

于“警报”类别的事故。这类事故包含与状态更改相关联的所有相关信息。

SLM 管理员可以配置触发警报的状态更改的类别。

您可以创建引发警报事故的数据库规则。这些规则可以触发操作，如向服务级

别经理或工作组专家发送电子邮件或生成 HP OpenView Operations 消息。

服务级别协议的管理

Service Level Manager 开始计算某项服务的符合性状态和可用性之前，您需要

将该服务与服务级别协议相关联，并且必须将该 SLA 置于 SLM 管理之下。可

用性和符合性的计算会根据服务级别协议的实际开始日期和结束日期自动开

启和关闭。通过临时从 SLM 管理中撤销服务级别协议，用户可以手动关闭可

用性和符合性的计算。这在某些情况下可能是必要的，例如在服务级别协议的

有效期内需要修改服务级别目标。

指标数据收集

所有可用性和符合性计算都是基于从外部监视应用程序或从服务台收集的分

析数据中提取的指标数据值。Service Level Manager 提供了指标适配器，安装

并配置该适配器之后，它将管理从受支持的监视应用程序中收集指标数据值

的流程。
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可用性和符合性报告

针对与服务级别管理流程相关联的特定角色， SLM OVPI 报告包提供了一组

预先配置的自定义报告。

一些报告提供了摘要信息， 另外一些报告提供了更加详细的信息。在生成摘要

报告并联机查看时，您可以选中感兴趣的行，以图形方式显示更加详细的信息。

报告还可以包含指向其它报告的超级链接，可以从其它角度显示信息。

在评估期内，可以按需调度或生成报告。可以通过 OpenView 控制台查看 

SLM 报告。图 1-3 显示了“服务”工作区中提供的报告。在该示例中，选择

了“服务详细信息报告”以显示有关 Service1 服务的信息。

图 1-3 查看服务的报告
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Service Level Manager 功能
最新可用性和符合性监视

SLM 员工可以在 OpenView 控制台中监视符合性和可用性计算的结果。由于

计算是在整个评估期内进行的，因此，服务级别协议、服务和配置项的总体状

态都是最新的。

预先配置的监视视图是针对特定 SLM 用户角色而设计的，并保证客户敏感信

息的保密性。

Web 控制台限制

由于在 Web 控制台中限制表单功能，因此建议您仅使用 Web 控制台查看 SLM 

信息；例如，监视可用性和符合性。您不能使用专门的用户界面字段类型，

如服务的“服务层次”、“符合性 SLO 表”和“SLO 表”属性。有关 Web 控

制台的详细信息，请参阅《HP OpenView Service Desk Administrator's Guide》。
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部署的类型
部署的类型

本节介绍 SLM 部署的两种类型： 整体式和分布式。

整体式部署

在此类型部署中，所有组件都安装在一台服务器上。图 1-4 说明了整体式部署

示例。

图 1-4 整体式部署示例
第 1 章 21



概述

部署的类型
分布式部署

在此类型部署中，组件分布在多台服务器上。图 1-5 说明了包括四台服务器的

分布式部署的示例： 一台服务器用于安装指标适配器（所有适配器都安装在

运行相应监视应用程序的同一系统上），第三台服务器上安装了 Service Desk

Management Server（在该服务器上运行 SLM 服务器进程），而第四台服务器

托管 HP OpenView 数据库以及 OVPI 报告服务器。

图 1-5 分布式部署示例
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Service Level Manager 角色

SLM 管理员帐户和角色
SLM 管理员帐户和角色

Service Level Manager 提供了应该用于以下管理任务的自定义用户帐户和角色：

• 配置常规 SLM 参数

• 配置指标适配器

• 检查指标适配器的状态

• 配置 SLM 报告

• 配置警报事故的触发

• 启动和停止 SLM 服务器进程

有关 SLM 配置任务的详细信息，请参阅 Service Desk 联机帮助。

SLM 管理员帐户

在安装 Service Desk Management Server 时，会自动创建“SLMAdministrator”
帐户。 SLM 管理员应该使用此帐户来配置 Service Level Manager。

“SLMAdministrator”帐户使用默认口令“slmadmin”进行安装。为了保
证安全性，建议您将其替换为非默认口令。

为“SLMAdministrator”帐户分配了“SLMAdministrator”角色。此角
色会在安装过程中自动安装。

SLM 核心帐户

在安装 Service Desk Management Server 时，会自动创建“SLMCore”帐户。由
于该帐户是集成帐户，因此它不提供对用户界面的访问权限。请勿删除 SLM 核

心帐户： Service Level Manager 任务需要使用该帐户与管理服务器进行通信。
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服务客户
服务客户

通过具备监视服务当前可用性的能力，服务客户可以从 Service Level Manager

的使用中受益。

监视当前服务可用性

客户可以监视其使用的服务的当前可用性状态。如果在访问那些服务时遇到

困难，该工具可以帮助他们查明原因。如果某项服务登记为当前可用，而客户

却无法访问它，则可能是遇到了不需要服务提供商帮助就可以解决的问题。
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服务设计人员
服务设计人员

服务设计人员使用 Service Level Manager 功能设计服务并建立服务模型。

设计服务

设计服务时，服务设计人员可能执行以下活动：

• 创建服务定义

• 维护服务定义

维护服务定义

维护服务定义时，服务设计人员可能执行以下活动：

• 响应变更现有服务定义的请求。变更请求通常由服务经理或客户关系经理

提出。

• 按服务经理或客户关系经理的要求，添加或修改配置项指标。

• 按服务经理或客户关系经理的要求，添加或修改服务级别目标阈值。

• 作为技术负责人参与某个自定义设计的功能设计活动。

建立服务模型

建立服务模型时，服务设计人员可能执行以下活动：

• 创建层次过滤器

• 基于层次过滤器创建受监视的服务
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服务经理
服务经理

服务经理使用 Service Level Manager 功能来创建标准的受监视服务以及自定

义的受监视服务。

创建受监视服务

服务经理将创建适合特定客户的受监视服务。为了测量受监视服务的符合性，

服务需要基于以下内容之一： 

• 由服务设计人员开发的服务定义。

• 指定服务层次中所需的配置项和附属服务的层次过滤器。

服务经理将添加特定客户专用的所有信息，包括服务时间、配置项的计划宕机

时间等。服务经理可与客户关系经理保持联络以确保此信息的准确性。

将服务与受管服务级别协议相关联

无论服务是如何创建的，都需要将其与服务级别协议相关联，并且需要将该服

务级别协议置于 SLM 管理之下。此任务通常由服务经理或客户关系经理执行。

将服务从其源服务定义中分离

如果客户关系经理请求一个无法应用于源服务定义的变更，则可能需要执行

此操作。
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客户关系经理
客户关系经理

客户关系经理使用 Service Level Manager 功能定义服务级别协议、在服务 － 

提供商组织内代表客户的利益以及监视当前服务的可用性。

定义服务级别协议

客户关系经理将帮助定义与特定客户相关的服务级别协议。

监视服务可用性和符合性

客户关系经理将监视由特定客户使用的服务的可用性和符合性。他们将确保

调查当前服务的不可用情况，并且如果需要，确保具有适当的应急计划。
第 2 章28



Service Level Manager 角色

服务计划人员
服务计划人员

服务计划人员将制定长期战略视图，该视图将比较目标与评估结果，以便识别

服务提供过度和不足。其目的是在不降低效率的前提下尽可能均匀地分配可

用资源，以便优化整体服务提供级别。

服务计划人员不监视当前可用性和符合性状态，因此，他们不使用最新监视

工具。服务计划人员专注于旨在阐明目标与结果之间的差异的报告。
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服务计划人员
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什么是指标数据收集？
什么是指标数据收集？

Service Level Manager 使用特定的 HP OpenView 监视应用程序来测量与受管服

务级别协议相关联的服务的可用性和符合性状态。如果没有这些监视应用程序

提供的指标数据值的常规集合，您无法在 OpenView 控制台中监视服务的符合

性状态，并且无法生成 SLM 报告。

为了收集指标数据值，Service Level Manager 提供了指标适配器。下表列出了

每个指标适配器以及与适配器一起使用的监视应用程序。

OVIS 指标适配器

通过安装和配置 OVIS 指标适配器，可以基于从已安装的 OVIS 数据库收集的

指标数据值来测量可用性和符合性。

OVPM 指标适配器

通过安装和配置 OVPM 指标适配器，可以基于 OpenView Performance Manager

服务器可用的指标数据来测量可用性和符合性。

Service Desk 指标适配器

在安装 Service Desk Management Server 时，会自动安装和配置 Service Desk 指

标适配器。使用此适配器，可以基于 Service Desk 应用程序服务器记录的分析

数据标准来测量可用性和符合性。

表 3-1 指标适配器

指标适配器 HP OpenView 监视应用程序

Ovisma Internet Services

Ovpmma Performance Manager

Ovsdma Service Desk

Ovsnma Operations Service Navigator
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OVSN 指标适配器

OVSN 指标适配器基于服务状态更改事件来收集和发布指标数据值。由于 

Service Navigator 服务可以对应于配置项或服务，因此，可以使用此指标适配

器来测量配置项的可用性以及服务的符合性。发现过程将标识出当前受监视

的所有 Service Navigator 服务。执行初始发现过程时，将会把每项服务的状态

发送给应用程序服务器。从那时起，指标适配器将发布每个状态更改事件。

OVSN 指标定义是根据 SPI 生成节点时遵守的规范进行确定的（请参阅

第 45 页上的“OVSN MRP 定义和 SPI 分析配置文件”）。 Service Navigator 

支持服务状态“Overall”和“Operational”。为了确保 OVSN 指标适配器从 

Service Navigator 收到可用的指标数据值，请不要禁用所有状态、不要禁用

“整体”状态，并且不要将默认状态从“整体”更改为“可运行”。

开放式指标适配器

开放式指标适配器是一个用于开发用户特定的 SLM 指标适配器的工具包，该

工具包可以从提供的指标适配器所支持的那些监视应用程序之外的其它监视

应用程序收集指标数据值。有关详细信息，请参阅《HP OpenView Service 

Desk Open Metric Adapter Developer Guide》。

启用指标数据收集

要启用指标数据值收集，需要执行以下操作：

1. 安装并配置要使用的监视应用程序。由于监视应用程序将为 SLM 服务器

提供指标数据值，因此，需要确保以下事项：

• 服务层次中的配置项的测量方法必须能够计算配置项的可用性。这适用

于每个叶节点配置项（即，在服务层次中没有附属配置项的配置项）。

层次中位置较高的配置项的可用性不需要基于指标数据值来计算；而

是基于可用性传播规则来计算。

• 每项服务的测量方法必须能够计算服务的符合性状态。如果决定仅基

于基础结构可用性指标来计算服务的符合性状态，则不需要以其它方

式测量该服务。

2. 为每个要使用的、已安装的监视应用程序安装并配置所需的指标适配器。

例如，如果将 HP OpenView Internet Services 用作监视应用程序，则需要

安装并配置 OVIS 指标适配器。有关安装指标适配器的说明，请参阅

《HP OpenView Service Desk 安装指南》。在安装 Service Desk 

Management Server 时，会自动安装和配置 OVSD 指标适配器。
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什么是指标数据收集？
3. 基于服务定义或层次过滤器创建受监视服务，然后指定贯穿整个底层基础

结构的指标和目标。

4. 将受监视服务置于 SLM 管理之下。受管服务级别协议处于活动状态后

（即，到达其实际开始日期后），指标适配器会自动开始收集指标数据值。

注释 必须先安装并配置与 OVIS、 OVPM 和 OVSN 指标适配器相关联的监视应用

程序，然后才能测试这些指标适配器。如果要在没有相关联的监视应用程序

的情况下模仿其中一个指标适配器的行为，请使用相应的指标适配器模拟器

（请参阅第 51 页上的“指标适配器模拟器”）。

无法访问的指标

对于与受管服务级别协议相关联的指标，如果在特定时段（过期期限）内没

有收集任何指标值，则指标的状态将从“可用”更改为“无法访问”。过期

期限由常规指标适配器配置设置 DefaultTaskExpirePeriod 指定或由特
定的指标适配器配置设置 ExpirePeriod 指定。（有关 

DefaultTaskExpirePeriod 和 ExpirePeriod 的详细信息，请参阅
第 35 页上的“指标适配器配置设置”。）

注释 未与受管服务级别协议相关联的指标的状态始终为“可用”。
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指标适配器配置文件
指标适配器配置文件

有关安装和配置指标适配器的说明，请参阅《HP OpenView Service Desk 安装

指南》。

安装指标适配器之后，应该验证是否在 OpenView 控制台中登记了该指标适

配器。

要验证指标适配器是否在 OpenView 控制台中已登记，请执行以下操作：

1. 使用 SLM 管理员帐户身份登录到 HP OpenView 控制台。

2. 从 OpenView 控制台，打开 SLM 工作区组。

3. 选择指标适配器工作区。

该指标适配器应该显示在列表中。在列表中看不到指标适配器的原因包括：

• SLM 服务器未运行。

• 指标适配器未运行。

• 指标适配器配置文件没有指定正确的 SLM 服务器。

指标适配器配置设置

配置设置存储在指标适配器配置文件中。建议您不要修改配置文件，除非指示

您这样做，例如，发布指南中包含以下说明时。每个配置设置都属于以下类别

之一：

• 指定特定指标适配器的行为或与 SLM 服务器的连通性的常规设置。

• 连接器设置是指标适配器专用的。这些设置指定连接到监视应用程序所需

的信息，如数据库用户 ID 和口令。

• 发现和位置过滤器是指标适配器专用的。这些过滤器指定如何减少在指标

发现过程中确定的指标量（在测试版中未实现）。

• 任务设置是指标适配器专用的。这些设置绑定在连接器上，并且指定为了

将指标数据值一起收集而对测量参考点进行分组的方式。

• 数据点设置是指标适配器专用的。这些数据点指定确定要收集的每个指标

数据所需的信息。
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常规指标适配器配置设置

除非明确声明，否则以下配置设置适用于所有类型的指标适配器：

• DataPointSynchronizationDelay

保留指标数据值的延迟期（从最近传递的值的时间戳开始计算）。

• DefaultTaskExpirePeriod

在任务配置中未指定过期期限时使用。此设置在由指标发现过程生成的

配置中使用。

• DefaultTaskPollingPeriod

在任务配置中未指定轮询间隔时使用。此设置在由指标发现过程生成的

配置中使用。

• DiscoveryInterval

已调度的发现轮询间隔（以秒为单位）。要禁用已调度的发现，请将此值

设置为 0。

• HeartBeatsInterval

运行状况轮询间隔（以秒为单位）。要禁用运行状况轮询，请将该值设置

为 0。

• IsEventBased

基于事件的标记。在发布每个指标数据点期间，用于通知服务器数据点

是基于事件的还是基于轮询的。对于 OVIS 指标适配器，此值为“0”

（轮询）。

• MrpDefinitionDiscoveryInterval

已调度的指标定义发现轮询间隔（以秒为单位）。值为 0（零）表示禁用

已调度的指标定义发现。

• Publisher.APP_NAME

由发布服务器使用的“存储和转发”客户机对象的应用程序名称。

• Publisher.DESTINATION

发送数据点时，发布服务器用作“存储和转发”目标的完整 URL。

• Publisher.MAX_FILE_BUFFER_SIZE

在通信中断的情况下，从指标适配器发布服务器到 SLM 核心的“存储和

转发”连接所使用的最大磁盘缓冲区大小（以 KB 为单位）。值为 0（零）

表示缓冲区大小没有限制（最大可达磁盘容量大小）。
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• Publisher.RESPONSE_TIMEOUT

由发布服务器使用的“存储和转发”客户机对象的 BBC 响应超时。

• SequenceNumber

指标适配器从配置服务器接收的配置数。

• ServerHost

SLM 服务器系统的名称。

• TypeByte

源类型标记。发布每个数据点时使用。值 (1) 通知服务器数据来自指标适
配器。保留其它值以供日后使用。

开放式指标适配器配置设置

以下配置设置特定于开放式指标适配器。

开放式指标适配器连接器配置设置

• Class

连接器类的名称（固定值： 

com.hp.ov.sd.slm.sa.openma.OpenConnector）

• DiscoveryMaxHistory

用于发现的时间过滤器（以分钟为单位）。早于指定时间的指标将被认

为已过期，并且会被忽略。如果此参数设置为 24*60，则忽略早于一天的

指标。

开放式指标适配器任务配置设置

• ConnectorRef

链接的连接器的名称（固定值： Open Connector）。

• ExpirePeriod

数据点过期的时间（以秒为单位）。如果此字段不存在，则使用在指标适

配器的常规设置中指定的“DefaultTaskExpirePeriod”值。

• PollingPeriod

调度此任务的轮询间隔。如果此字段不存在，则使用在指标适配器的常规

设置中指定的“DefaultTaskPollingPeriod”值。
第 3 章 37



指标数据收集

指标适配器配置文件
开放式指标适配器数据点配置设置

• MetricTypeValue1

用户定义的指标定义属性 1。

• MetricTypeName1

用户定义的指标定义属性“Metric Type Value 1”的显示名称。

• MetricTypeValue2

用户定义的指标定义属性 2。

• MetricTypeName2

用户定义的指标定义属性“Metric Type Value 2”的显示名称。

• MetricTypeValue3

用户定义的指标定义属性 3。

• MetricTypeName3

用户定义的指标定义属性“Metric Type Value 3”的显示名称。

• MetricTypeValue4

用户定义的指标定义属性 4。

• MetricTypeName4

用户定义的指标定义属性“Metric Type Value 4”的显示名称。

• SourceIdentifier

生成指标的监视应用程序的名称。

• User Data Value 1

用户定义的指标属性 1。

• User Data Name 1

用户定义的指标属性“User Data Value 1”的显示名称。

• User Data Value 2

用户定义的指标属性 2。

• User Data Name 2

用户定义的指标属性“User Data Value 2”的显示名称。
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• User Data Value 3

用户定义的指标属性 3。

• User Data Name 3

用户定义的指标属性“User Data Value 3”的显示名称。

• User Data Value 4

用户定义的指标属性 4。

• User Data Name 4

用户定义的指标属性“User Data Value 4”的显示名称。

• User Data Value 5

用户定义的指标属性 5。

• User Data Name 5

用户定义的指标属性“User Data Value 5”的显示名称。

• User Data Value 6

用户定义的指标属性 6。

• User Data Name 6

用户定义的指标属性“User Data Value 6”的显示名称。

OVIS 配置设置

以下配置设置特定于 OVIS 指标适配器。

OVIS 连接器配置设置

• Class

连接器类的名称（固定值： com.hp.ov.sd.slm.sa.ovis.Connector）

• DBName

OVIS 数据库的名称。

• DiscoveryMaxHistory

用于发现的时间过滤器（以分钟为单位）。早于指定时间的指标将被认

为已过期，并且会被忽略。如果此参数设置为 24*60，则忽略早于一天的

指标。
第 3 章 39



指标数据收集

指标适配器配置文件
• DriverName

用于连接的 JDBC 驱动程序名称。

• Host

安装 OVIS 的主机名或 IP 地址。

• Login

OVIS 数据库登录名。

• NbReconnection

尝试连接到 OVIS 数据库的次数。

• Password

OVIS 数据库口令。

• Port

OVIS 数据库实例的端口号。

• Table

OVIS 数据库表的名称（默认值： IOPS_DETAIL_DATA）。

• Timeout

JDBC 连接超时（以秒为单位）。

• URL

JDBC 驱动程序的完整 URL 连接字符串。

OVIS 任务配置设置

• Connector

链接的连接器的名称。

• ExpirePeriod

数据点过期的时间（以秒为单位）。如果此字段不存在，则使用在指标适

配器的常规设置中指定的“DefaultTaskExpirePeriod”值。

• Filter

此任务使用的 SQL 查询中的 WHERE 语句的一部分。默认情况下，仅过滤
与 PROBENAME 相关的数据。
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• MaxHistoryLimit

干净启动过程中第一次请求的最大历史记录间隔（以秒为单位）。

• PollingPeriod

调度此任务的轮询间隔。如果此字段不存在，则使用在指标适配器的常规

设置中指定的“DefaultTaskPollingPeriod”值。

• Table

如果任务使用在连接器配置设置中指定的表名称，则为 OVIS 数据库表或

%TABLE% 的名称。

OVIS 数据点配置设置

• Host

OVIS 中“HOST”字段的值（即受监视系统的名称）。

• Metric

IOPS_DETAIL_DATA 表中指定指标类型（例如， AVAILABILITY、
TRANFERTPUT、 RESPONSETIME 或 SETUPTIME）的字段名。

• Probe

探测器类型。

• System

OVIS 中“SYSTEM”字段的值（即 OVIS 服务器的名称）。

• Target

OVIS 中“TARGET”字段的值（取决于探测器）。

OVPM 配置设置

以下配置设置特定于 OVPM 指标适配器。

OVPM 连接器配置设置

• Class

连接器类的名称（固定值： com.hp.ov.sd.slm.sa.ovpm.Connector）

• Host

安装 OVPM 的主机名或 IP 地址。
第 3 章 41



指标数据收集

指标适配器配置文件
• Login

OVPM 用户帐户的登录名。

• NbReconnection

尝试连接到 OVPM 服务器的次数。

• Password

OVPM 用户帐户的口令。

• Port

运行 OVPM 实例的端口号。

• URL

OVPM 的完整 URL 连接字符串。

OVPM 任务配置设置

• Connector

链接的连接器的名称。

• ExpirePeriod

数据点过期的时间（以秒为单位）。如果此字段不存在，则使用在指标适

配器的常规设置中指定的“DefaultTaskExpirePeriod”值。

• Filter

应用到测量参考点收集的过滤器，取决于所实现的连接。

• MaxHistoryLimit

干净启动过程中第一次请求的最大历史记录间隔（以秒为单位）。

• MonitoredSystem

在 OVPM 内配置的受监视系统的名称。

• PollingPeriod

调度此任务的轮询间隔。如果此字段不存在，则使用在指标适配器的常规

设置中指定的“DefaultTaskPollingPeriod”值。

• TimeDiff

时差（固定值：0）。
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OVPM 数据点配置设置

• Metric

OVPM 指标名称。

• OvpmClass

指标所属的类名称。

• OvpmFilter

可选的过滤器字符串。

• OvpmServer

安装 OVPM 的主机名或 IP 地址。

• OvpmSystem

在 OVPM 中配置的受监视系统的名称。

OVSN 配置设置

以下配置设置特定于 OVSN 指标适配器。

OVSN 连接器配置设置

• Class

连接器类的名称（固定值： com.hp.ov.sd.slm.sa.ovsn.Connector）

• Host

安装 OVSN 的主机名或 IP 地址。

• NbReconnction

连接的次数。

• Port

运行 OVSN 的端口号（默认值是 7278）。

• Timeout

JDBC 连接超时（以秒为单位）。
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OVSN 任务配置设置

• Connector

链接的连接器的名称。

• PollingPeriod

调度此任务的轮询间隔。由于 OVSN 指标适配器是基于事件的，因此，

它使用此值定期检查侦听器组件的状态。

OVSN 数据点配置设置

• Host

OVSN 服务器的名称。

• Label

标识节点的文本。

• Metric

在 OVSN 中配置的服务的名称。
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OVSN MRP 定义和 SPI 分析配置文件

本节介绍用于 OVSN MRP 定义和 OVSN SPI 分析的配置文件。

OVSN MRP 定义

与在其它监视应用程序中发现的测量参考点定义不同， OVSN MRP 定义的特

征是有一个并非直接来自 OpenView Service Navigator 的文本字段。

OVSN 节点的服务名也映射到 OVSN MRP 字段“Metric”中。

节点名和服务名由 SPI 自动生成。SPI 将根据其输入和能力发现拓扑并生成多

个子节点。

然后，需要将文本的一部分标识为指标位置，而将另一部分标识为指标定义。

示例 1

• Oracle:Listener:139.50.38.157

— Oracle:Listener

— 139.50.38.157

• Oracle:EC:139.50.38.157

— Oracle:EC

— 139.50.38.157

• OVOAgent:139.50.37.185

— OVOAgent

— 139.50.37.185

• SLM

— SLM

—
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示例 2

• OSSPI:phydisk@@ovsolt17.india.hp.com

— OSSPI:phydisk

— ovsolt17.india.hp.com

• OSSPI:phydisk:/dev/rdsk/c0t0d0s0@@ovsolt17.india.hp.com

— OSSPI:phydisk:/dev/rdsk/c0t0d0s0

— ovsolt17.india.hp.com

• OSSPI:netif@@ovsolt17.india.hp.com

— OSSPI:netif

— ovsolt17.india.hp.com

• OSSPI:netif:eri0@@ovsolt17.india.hp.com

— OSSPI:netif:eri0

— ovsolt17.india.hp.com

• OSSPI:netif:eri0:net@@ovsolt17.india.hp.com

— OSSPI:netif:eri0:net

— ovsolt17.india.hp.com

示例 3

此示例是理论上的，不依赖于实际 SPI。

• MyFirstKey(somewhere.hp.com)MySecondKey

— MyFirstKeyMySecondKey

— somewhere.hp.com

• MyFirstKey(shortname(.hp.com))MySecondKey

— MyFirstKeyMySecondKey

— Shortname(.hp.com)
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线性分析

线性分析包括在边界之间将光标从左移到右或从右移到左以寻找分隔符。分隔

符之间的文本从定义或从位置中提取。

OVSN SPI 分析配置文件

OvsnMA_SpiParsing.xml 文件与 OvsnMA.xml 配置文件位于同一位置。

此配置文件的目的是指定如何分隔指标定义和指标位置。

<!--

Don't forget to replace XML special characters to references. 

Character   Reference

&       &amp;

<       &lt;

>       &gt;

"       &quot;

'       &apos;

-->

<SpiParsingList>

    <!— DEFI:NIT:ION:LOCATION -->

    <SpiLinearParsing>

        <LinearLeftParsing>

            <DefinitionExtraction/>

            <Delimiter extract=”none”>:</Delimiter>

            <LocationExtraction>

        <LinearLeftParsing>

    </SpiLinearParsing>

    <!— DEFINITION@@LOC@@TION -->
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    <SpiLinearParsing>

        <LinearRightParsing>

            <DefinitionExtraction>

            <Delimiter extract=”none”>@@</Delimiter>

            <LocationExtraction>

        </LinearRightParsing>

    </SpiLinearParsing>

    <!— DEF(LOC(A)TION)INITION -->

    <SpiLinearParsing>

        <LinearRightParsing>

            <DefinitionExtraction/>

            <Delimiter extract=”none”>(</Delimiter>

            <LocationExtraction/>

        </LinearRightParsing>

        <LinearLeftParsing>

            <Delimiter extract=”none”>)</Delimiter>

            <DefinitionExtraction/>

        </LinearLeftParsing>

    </SpiLinearParsing>

    <!— “CPU”_LOCATION -->

    <SpiLinearParsing>

        <LinearRightParsing>

            <Delimiter extract=”Definition”>CPU</Delimiter>

            <Delimiter extract=”none>_</Delimiter>

            <LocationExtraction/>

        </LinearRightParsing>

    </SpiLinearParsing>

    <!— “DISK”_LOCATION -->
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    <SpiLinearParsing>

        <LinearRightParsing>

            <Delimiter extract=”Definition”>DISK</Delimiter>

            <Delimiter extract=”none>_</Delimiter>

            <LocationExtraction/>

        </LinearRightParsing>

    </SpiLinearParsing>

    ...

    ...

</SpiParsingList>

OVSN SPI 分析配置设置

• SpiParsingList

包含 SPI 分析结果列表。适配器将查看列表中的每个分析，直到它找到一

个匹配的分析（即，找到所有分隔符）。

• SpiLinearParsing

SPI 的分析规范，使用线性分析。

• LinearRightParsing

从左到右进行分析。从左到右定义内部标记。

• LinearLeftParsing

从右到左进行分析。从右到左定义内部标记。

• DefinitionExtraction

要提取到定义中的部分。

• LocationExtraction

要提取到位置中的部分。

• Delimiter extract=”none”

作为分析方向的分隔符。找到的分隔符将从定义文本和位置文本中排除。
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• Delimiter extract=”Definition”

作为分析方向的分隔符。找到的分隔符将包括在定义文本中。此分隔符对

于字符串匹配也非常有用。

• Delimiter extract=”Location”

作为分析方向的分隔符。找到的分隔符将包括在位置文本中。此分隔符对

于字符串匹配也非常有用。

分析流程示例

根据使用的是 LinearRightParsing 还是 LinearLeftParsing 标记，将采
用不同的方式来处理输入数据。但是，定义要分析的内容后再对其进行排序的

方法始终是按从左到右的顺序进行的。

假定有一个示例，使用以下 SPI 配置文件来分析字符串 

OSSPI:def1@@hostname1@@def2：

<SpiParsingList>

    <SpiLinearParsing>

        <LinearRightParsing>

            <DefinitionExtraction/>

            <Delimiter extract="none">@@</Delimiter>

            <LocationExtraction/>

        </LinearRightParsing>

    </SpiLinearParsing>

</SpiParsingList>

结果如下所示：

• Definition:OSSPI:def1

• Location:hostname1@@def2

分析流程如下：

光标从左向右扫描，以匹配第一个 @@。用另一种方式表示： 光标从右向左扫

描，以匹配最后一个 @@。

然后，原始字符串被分为两个部分： OSSPI:def1 和 hostname1@@def2。左
侧的部分 OSSPI:def1 映射到 DefinitionExtraction 标记；右侧的部分
hostname1@@def2 映射到 LocationExtraction 标记。
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指标适配器模拟器

通过指标适配器模拟器， SLM 管理员、服务设计人员和服务经理可以模拟

OVIS、OVPM 和 OVSN 指标适配器的行为，而不需要安装和配置相关联的监

视应用程序。

指标适配器模拟器将模拟以下功能：

• 指标发现

• 收集数据点并传递给 SLM 服务器

• 运行状况轮询（检查指标适配器模拟器的可用性）

配置指标适配器模拟器

1. 定义指标适配器配置文件（第 51 页）

2. 创建指标适配器模拟器输入文件（第 53 页）

3. 启动指标适配器模拟器（第 58 页）

定义指标适配器配置文件

需要定义指标适配器模拟器使用的配置文件。配置文件的名称必须以 Ovis、

Ovpm、Ovsn 或 Open 开头，并以 MA 结尾（例如，OvisSimulatorMA.xml 和

OvisTestMA.xml）。

OvisSimulatorMA.xml 的配置文件如下所示：

图 3-1 OVIS 指标适配器模拟器的配置文件

<?xml version="1.0" encoding="UTF-8"?>

<Config>

    <MA name="OvisSimulatorMA">

        <Publisher.BUFFER_PATH/>

        <Publisher.APP_NAME>OvisSimulatorMASimulator</Publisher.APP_NAME>

        <ServerHost>localhost</ServerHost>

        <Publisher.MAX_FILE_BUFFER_SIZE/>

        <DefaultTaskPollingPeriod>300</DefaultTaskPollingPeriod>
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        <DataPointVersionByte>1</DataPointVersionByte>

        <DataPointSynchronizationDelay>10</DataPointSynchronizationDelay>

<Publisher.BUFFERSIZE_OUTPUT_STREAM>0</Publisher.BUFFERSIZE_OUTPUT_STREAM>

        <TypeByte>1</TypeByte>

        <isEventBased>0</isEventBased>

        <SequenceNumber>0</SequenceNumber>

        <Publisher.RESPONSE_TIMEOUT>60</Publisher.RESPONSE_TIMEOUT>

        <HeartBeatsInterval>300</HeartBeatsInterval>

        <DiscoveryInterval>0</DiscoveryInterval>

        <DefaultTaskExpirePeriod>600</DefaultTaskExpirePeriod>

    </MA>

    <Connector name="input1">

        <Class>com.hp.ov.sd.slm.sa.simulator.Connector</Class>

        <File>OvisSimulatorMAInput.txt</File>

    </Connector>

    <Task name="Task1">

        <Connector>input1</Connector>

    </Task>

    <DiscoveryLocationFilter>

        <All/>

    </DiscoveryLocationFilter>

    <DiscoveryMrpDefinitionFilter>

        <All/>

    </DiscoveryMrpDefinitionFilter>

</Config>
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对于 OVPM 和 OVSN 指标适配器模拟器，需要将以下位置中的字符串 

OvisSimulatorMA 替换为 OvpmSimulatorMA 或 OvsnSimulatorMA：

<MA name="OvisSimulatorMA">

        <Publisher.APP_NAME>OvisSimulatorMASimulator</Publisher.APP_NAME>

        <File>OvisSimulatorMAInput.txt</File>

可以减少以下参数的值来加快测试的速度：

• DataPointSynchronizationDelay

• DefaultTaskPollingPeriod

创建指标适配器模拟器输入文件

需要创建指标适配器模拟器输入文件来定义模拟的基础。需要在指标适配器模

拟配置文件中指定输入文件（在第 51 页上的“定义指标适配器配置文件”一

节的配置文件示例中，输入文件的名称为 OvisSimulatorMAInput.txt）。

输入文件将指定以下信息：

• 要发现的指标

为每个发现的指标指定的名称遵循发现指标的一般命名惯例（有关详细

信息，请参阅 Service Desk 联机帮助）。

• 要定期发送给 SLM 服务器的数据点列表（以制表符分隔）

在每个任务轮询期间模拟器将迭代至值列表中的下一个值。每次到达列表

末尾时，模拟器将返回列表的开始处。

要创建指标适配器模拟器输入文件，请执行以下操作：

• 将其中的一个输入文件示例用作模板：
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指标适配器模拟器输入文件示例

OVIS 指标适配器模拟器输入文件示例

#

# The following section defines the Measurement Points

#

<?xml version="1.0" encoding="UTF-8"?>

<Discovery>

<MRP

name="RESPONSETIME_HTTP_probed.hp.com/_something_probed.hp.com_ovisserver.hp.com

">

<Probe>HTTP</Probe>

<Unit>Seconds</Unit>

<TargetHost>probed.hp.com</TargetHost>

<Metric>RESPONSETIME</Metric>

<TargetInfo>probed.hp.com/</TargetInfo>

<System>ovisserver.hp.com</System>

<Type>Double</Type>

<TaskRef>Task1</TaskRef>

<Customer>someone</Customer>

<ServiceName>something</ServiceName>

<Location>probed.hp.com</Location>

</MRP>

<MRP name="

AVAILABILITY_HTTP_probed.hp.com/_something_probed.hp.com_ovisserver.hp.com">

<Probe>HTTP</Probe>

<Unit>Percent</Unit>

<TargetHost>probed.hp.com</TargetHost>

<Metric>AVAILABILITY</Metric>

<TargetInfo>probed.hp.com/</TargetInfo>
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<System>ovisserver.hp.com</System>

<Type>Double</Type>

<TaskRef>Task1</TaskRef>

<Customer>someone</Customer>

<ServiceName>something</ServiceName>

<Location>probed.hp.com</Location>

</MRP>

</Discovery>

#

# The following section defines the Datapoint values

#

<DataPointValues>

RESPONSETIME_HTTP_probed.hp.com/_something_probed.hp.com_ovisserver.hp.com 1.1

1.2 1.3 1.4

AVAILABILITY_HTTP_probed.hp.com/_something_probed.hp.com_ovisserver.hp.com 1 1 0

1

</DataPointValues>

OVPM 指标适配器模拟器输入文件示例

# 

# The following section defines the Measurement Points

#

<?xml version="1.0" encoding="UTF-8"?>

<Discovery>

    <MRP name=" 
PROC_MEM_RES_PROC_PROC_NAME=explorer_PROCESS_probed.hp.com+(MWA)_ovpmserver">

        <Type>Integer</Type>

        <TaskRef>Task1</TaskRef>

        <OvpmSystem>probed.hp.com+(MWA)</OvpmSystem>

        <OvpmServer>ovpmserver</OvpmServer>

        <Metric>PROC_MEM_RES</Metric>
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        <OvpmClass>PROCESS</OvpmClass>

        <OvpmFilter>PROC_PROC_NAME=explorer</OvpmFilter>

        <Location>probed.hp.com</Location>

    </MRP>

    <MRP name="GBL_CPU_TOTAL_UTIL__GLOBAL_probed.hp.com+(MWA)_ovpmserver">

        <Type>Double</Type>

        <TaskRef>Task1</TaskRef>

        <OvpmSystem>probed.hp.com+(MWA)</OvpmSystem>

        <OvpmServer>ovpmserver</OvpmServer>

        <Metric>GBL_CPU_TOTAL_UTIL</Metric>

        <OvpmClass>GLOBAL</OvpmClass>

        <OvpmFilter></OvpmFilter>

        <Location>probed.hp.com</Location>

    </MRP>

</Discovery>

# 

# The following section defines the Datapoint values

#

<DataPointValues>

PROC_MEM_RES_PROC_PROC_NAME=explorer_PROCESS_probed.hp.com+(MWA)_ovpmserver
10000 20000 30000

GBL_CPU_TOTAL_UTIL__GLOBAL_probed.hp.com+(MWA)_ovpmserver10.0 10.5 11.0 11.5

</DataPointValues>
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OVSN 指标适配器模拟器输入文件示例

# 

# The following section defines the Measurement Points

#

<?xml version="1.0" encoding="UTF-8"?>

<Discovery>

    <MRP name="W2K:IISADMIN:probed.hp.com_ovsnserver.hp.com">

        <Type>Integer</Type>

        <TaskRef>Task1</TaskRef>

        <MetricDefinition>W2K:IISADMIN</MetricDefinition>

        <Metric>W2K:IISADMIN:probed.hp.com</Metric>

        <OvsnServer>ovsnserver.hp.com</OvsnServer>

        <Label>W2K:IISADMIN:probed.hp.com label</Label>

        <Location>probed.hp.com </Location>

    </MRP>

    <MRP name="SAP: probed.hp.com_ovsnserver.hp.com">

        <Type>Integer</Type>

        <TaskRef>Task1</TaskRef>

        <MetricDefinition>SAP</MetricDefinition>

        <Metric>SAP: probed.hp.com</Metric>

        <OvsnServer>ovsnserver.hp.com</OvsnServer>

        <Label>SAP: probed.hp.com_ovsnserver.hp.com label</Label>

        <Location>probed.hp.com</Location>

    </MRP>

</Discovery>

# 

# The following section defines the Datapoint values

#

<DataPointValues>

W2K:IISADMIN:probed.hp.com_ovsnserver.hp.com 1 2 4 8

SAP:probed.hp.com_ovsnserver.hp.com 0 1 2 4

</DataPointValues>
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启动指标适配器模拟器

要启动指标适配器模拟器，请执行以下操作： 

• 在命令行提示符后，运行适用于您的操作系统的相应命令（请参阅

表 3-2）：

例如，要在 Windows 上启动 OVIS 指标适配器模拟器，请在命令行提示符后

运行以下命令：

startMASimulator.bat OvisSimulatorMA

表 3-2 指标适配器模拟器启动命令

操作系统 脚本

Windows startMASimulator.bat 

[OvisSimulatorMA | OvpmSimulatorMA | OvsnSimulatorMA]

HP-UX、
Solaris

startMASimulator.sh 

[OvisSimulatorMA | OvpmSimulatorMA | OvsnSimulatorMA]
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本章介绍计算引擎如何对受监视服务执行可用性和符合性计算。
第 4 章 59



可用性和符合性计算

可用性和符合性计算概述
可用性和符合性计算概述

Service Level Manager 包含一个计算引擎，它可以根据与服务接受方议定的目标

来测量配置项、服务和服务级别协议的性能。

将基于以下因素进行计算：

• 针对每个为服务层次中的配置项和服务指定的指标，由用户定义的指标

目标。

所有符合性状态计算都基于通过计算得出的配置项指标的目标状态以及

服务指标的目标状态（请参阅第 61 页上的“指标目标状态”）。

• 用户定义的指标计算和可用性传播规则。

这些规则确定了需要实现多少指标目标以及需要多少附属服务和配置项

处于可用状态（请参阅第 66 页上的“指标计算规则”和第 67 页上的

“可用性传播规则”）。

• 与服务接受方议定的服务时间。

在可用性和符合性计算中将忽略服务时间之外未实现的指标目标。

• 为配置项指定的计划宕机时间。

在可用性和符合性计算中，将忽略计划宕机时间段内未实现的指标目标。
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指标目标状态
指标目标状态

所有可用性和符合性计算都基于由 SLM 员工指定的指标目标以及由计算引擎

计算的指标目标的状态。

SLM 员工可以为服务层次中的每个配置项指标和服务指标指定指标目标。在可

用性和符合性计算中，将包括指定了目标的指标。在可用性和符合性计算中，

将忽略未指定目标的指标，但是这些指标仍收集在 SLM 报告中。

指标目标由目标阈值和运算符组成。这些属性一起指定了与指标适配器提供的

指标数据值的比较目标。每当指标适配器发送指标数据值时，目标状态计算都

会将此值与相应的目标阈值进行比较。比较结果将指明当前的指标目标状态；

即，目标是已实现还是未实现。

例如，假设配置项指标的指标数据值可以介于 0 和 1 之间，并且指定了阈值为

0.5 和目标条件为“大于”的指标目标。如果指标适配器发送的指标数据值为

0.7，则该指标的目标状态已实现。如果指标适配器发送的指标数据值为 0.2，

则该指标的目标状态尚未实现。

图 4-1 显示了一个简图，说明了几个小时内特定指标目标的目标状态。如果用

户在下午 3 点监视配置项指标，目标状态显示为“未实现”。这种状态一直持

续到下午 4 点，这时指标适配器发送了大于阈值的指标数据值。如果用户在下

午 5 点监视配置项指标，则目标状态显示为“已实现”。

图 4-1 指标目标状态示例

如果指标适配器无法发送指标数据值，根据已配置的指标不可用策略，目标状态

计算将使用假定的目标状态（有关详细信息，请参阅 Service Desk 联机帮助）。
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指定指标目标时， SLM 员工应该考虑相应的指标适配器将从计算引擎接收以

及发送给计算引擎的指标数据值的可能范围。例如， Internet 服务可用性探测

器（如 ICMP Ping）将值 0 或 1 传递给 OVIS 指标适配器。适用的指标目标可

能包括阈值 0.5 和 >（大于）运算符，或阈值 1 和 >=（大于或等于）运算符。

通过参考 Internet 服务控制面板中显示的响应时间的历史记录，可以选择适用

于 OVIS 响应时间探测器的目标。

配置项指标的目标状态

配置项指标的目标状态提供了在相关联的服务级别协议的当前评估期内配置

项运行情况的快照。例如，图 4-2 表示测量 Load Balancer Berlin 是否遵守 Web

Service Berlin 服务级别协议的配置项指标的目标状态当前已实现：

图 4-2 配置项指标的目标状态

所有配置项指标的目标状态都要进行计算，如第 61 页上的“指标目标状态”

中所述。
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指标目标状态
服务指标的目标状态

服务指标的目标状态提供了在相关联的服务级别协议的当前评估期内服务指

标运行情况的快照。例如，图 4-3 显示 Web Service Berlin 的两个服务指标的

目标状态当前已实现，而第三个服务指标的目标状态尚未进行计算：

图 4-3 服务指标的目标状态

除基础结构可用性指标之外，所有服务指标的目标状态都要进行计算，如

第 61 页上的“指标目标状态”中所述。

基础结构可用性指标的目标状态的计算方法在第 65 页上的“服务基础结构

可用性”中进行说明。

服务指标的目标状态在整个当前评估期内进行测量，以计算服务指标的符合

性状态（请参阅第 69 页上的“服务指标的符合性状态”）。
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可用性
可用性

Service Level Manager 将对服务层次中的以下对象类型执行可用性计算：

• 配置项

可以针对整个服务层次中的所有配置项计算可用性。配置项的可用性状态

指明配置项是否工作正常。配置项或者可用，或者不可用。应该将不可用的

配置项分配给专家，进行调查和修复。通过查看每个配置项的可用性状态，

专家能够了解配置项未遵守其可用性传播规则的原因，或服务未能实现其

基础结构可用性目标的原因（请参阅第 64 页上的“配置项可用性”）。

• 服务

如果服务的基础结构可用性指标的目标状态已实现，则该服务可用（请参

阅第 65 页上的“服务基础结构可用性”）。

仅对与置于 SLM 管理之下的、有效的服务级别协议相关联的对象执行可用性

计算。由于目标值应用于特定的服务级别，因此，每个可用性计算的结果都对

应于特定的服务级别协议。对于指定的对象类型，每个与顶级服务相关联的、

有效的服务级别协议都有一个目标值。这意味着，例如，某个特定的共享配置

项可用于一个服务级别协议，而对于另一个服务级别协议则不可用。

配置项可用性

配置项可用性计算将考虑以下因素：

• 配置项当前是否遵守其指标计算规则？（请参阅第 66 页）。

• 配置项当前是否遵守其可用性传播规则？（请参阅第 67 页）。
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可用性
如果配置项当前遵守这两个规则，它将被定义为可用。如果配置项违反任何一

个规则，则不可用。

图 4-4 配置项可用性计算

如果服务层次包含的配置项没有完全为其指标定义目标，或者未定义指标，

则指标计算规则将被忽略。可用性将基于配置项的可用性传播规则及其附属

配置项的可用性进行计算。

无法仅基于可用性传播规则来正确计算叶节点配置项（即，在层次中没有附

属配置项的配置项）的可用性。除了指定伴随的目标，应该至少为叶节点配置

项指定一个指标。

服务基础结构可用性

如果服务的基础结构可用性目标当前已实现，则该服务当前可用。如果服务当

前遵守其可用性传播规则（请参阅第 67 页），则该服务的基础结构可用性目

标已实现。
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指标计算规则

您可以指定服务层次中每个配置项的指标计算规则。指标计算规则将对配置

项需要实现的指标目标数强制执行某种条件。如果违反该规则，将认为此配置

项不可用。

下表列出了可以为配置项选择的指标计算规则。

将根据配置项执行的功能分配最适当的规则：

• 对于任一指标目标未实现则认为不可用的配置项，为它们分配“达到所有

指标目标”规则。例如，如果服务设计人员为指标目标（测试 Web 服务

器的以下标准）指定了此规则，那么，如果任一指标目标未实现，则认为

违反了该规则：

— Web 服务器服务是否在运行？

— 是否可以访问 Web 服务器的文件系统？

• 对于所有指标目标都未实现时才认为不可用的配置项，为它们分配“至少

达到一个指标目标”规则。例如，如果服务设计人员为指标目标（测试服

务器上运行的应用程序的以下标准）指定了此规则，那么，如果两个目标

都未实现，则认为违反了该规则：

— 可以通过 PC 客户机访问应用程序吗？

— 可以通过 Web 客户机访问应用程序吗？

表 4-1 指标计算规则

规则 说明

达到所有指标目标 必须实现配置项的所有指标目标。

至少达到一个指标目标 必须至少实现配置项的一个指标目标。
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可用性
可用性传播规则

您可以为服务基础结构中的每个配置项和服务分配可用性传播规则。可用性

传播规则将对必须可用的附属配置项或服务的数目强制执行某种条件。如果

违反该规则，将认为配置项或服务不可用。

表 4-2 列出了可以为服务选择的可用性传播规则。

表 4-3 列出了可以为配置项选择的可用性传播规则。

将根据附属配置项和服务所执行的功能为服务或配置项分配的最适当的规则：

• 对于任一附属配置项和服务不可用则认为不可用的配置项和服务，为它们

分配“所有子级都可用”规则。

• 对于所有附属配置项和服务都不可用才认为不可用的配置项和服务，为它

们分配“至少有一个子级可用”规则。

表 4-2 用于服务的可用性传播规则

规则 说明

所有子级都可用 由“已用的配置项”属性连接的所有已用的配置项

和由“使用服务”属性连接的服务基础结构当前必

须可用。

至少有一个子级可用 至少一个由“已用的配置项”属性连接的已用的配

置项或由“使用服务”属性连接的服务基础结构当

前必须可用。

表 4-3 用于配置项的可用性传播规则

规则 说明

所有子级都可用 由“关联配置项”属性连接的所有配置项当前必须

可用。

至少有一个子级可用 至少一个由“关联配置项”属性连接的配置项当前

必须可用。
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可用性
图 4-5 显示了服务层次中顶层服务的可用性传播规则考虑的因素。这些因素

包括：

• 顶级服务所使用的每个配置项的可用性。仅考虑通过“已用的配置项”属

性与顶级服务相关联的配置项。有关如何计算配置项可用性的说明，请参

阅第 64 页上的“配置项可用性”。

• 顶级服务所使用的服务的基础结构可用性。仅考虑通过“使用服务”属性

与顶级服务相关联的服务。如果已使用的服务与两个或两个以上有效的服

务级别协议相关联（例如，图 4-5 中的 SLA2 和 SLA3），则可用性传播

规则将使用最差的基础结构可用性。

图 4-5 基础结构可用性计算
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符合性
符合性

Service Level Manager 将对以下与有效的服务级别协议相关联的对象类型执行

符合性计算：

• 服务

将针对相关联的每个有效服务级别协议计算服务的符合性状态（请参阅

第 72 页上的“服务的符合性状态”）

• 服务级别协议

针对所有有效的服务级别协议计算符合性状态（请参阅第 73 页上的

“服务级别协议的符合性状态”）

服务指标的符合性状态

在评估期内，对于每个与有效服务级别协议相关联的服务指标，将计算其符合

性状态。这些测量将确定服务和服务级别协议是否相符。

计算符合性状态的方式取决于服务指标的指标类别：

• 需要在一段时间内聚集标准指标和基础结构指标，以计算符合性百分比。

然后，符合性百分比将与符合性阈值进行比较，以计算符合性状态（请参

阅第 70 页上的“标准服务指标和基础结构服务指标的符合性状态”）。

• 指标适配器将指标数据值发送给计算引擎时，聚集指标已进行了聚集。

这些值将与其指标目标进行比较，以计算符合性状态。
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标准服务指标和基础结构服务指标的符合性状态

符合性计算会累计服务时间内服务指标没有达到目标状态的时段。从总服务

时间（即，当前评估期内调度的服务时间的总持续时间）减去此值（总冲突

时间），然后除以总服务时间。此计算的结果就是服务指标的符合性百分比

（请参阅图 4-6）。

由于总服务时间是固定的，在整个当前评估期内只有冲突时间是可以增加的，

因此，在评估期内符合性百分比永远不会增加。

图 4-6 符合性百分比计算公式

将符合性百分比与符合性冲突阈值（如果已指定此值）进行比较，以确定符合

性状态（即，是符合服务指标，还是不符合服务指标）。

图 4-7 中的服务指标状态表单给出了 OVIS Responsetime HTTP 服务指标的符

合性百分比计算示例。在本示例中，相关联的服务级别协议是以每月为评估期

的，并且没有服务时间计划表（即，服务时间是连续的，一个月以 30 天计算

就是 720 小时）。由于总冲突时间是 3 小时 20 分钟，因此，符合性百分比的

计算结果为 ((720-3.333)/720)*100 = 99.54%。

图 4-7 符合性百分比计算示例

如果指定了符合性危险阈值，符合性计算会将符合性百分比与危险阈值以及冲

突阈值进行比较，以确定符合性状态是“符合”、“危险”还是“冲突”。通

过指定符合性危险阈值， Service Level Manager 可以在符合性状态从“符合”

更改为“冲突”之前，警告符合性百分比下降正接近其冲突阈值。您最多可以

指定三个危险阈值，每个阈值包含不同的程度代码。

Compliance Percentage
Total Service Time Violation Time–( )

Total Service Time
--------------------------------------------------------------------------- 100×=
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图 4-8 显示了目标的符合性状态由于受到未实现目标的时间段的影响而下降

的情况。

图 4-8 标准服务指标和基础结构服务指标的符合性状态

标准服务指标和基础结构服务指标的预测符合性状态

假设在评估期的剩余时间内继续保持当前的趋势，符合性计算可预测当前评

估期结束时的服务指标的符合性状态。

图 4-9 给出了预测符合性百分比的计算公式。预测符合性百分比计算与符合性

百分比计算的区别在于，前者使用当前评估期截止目前（即截止预测计算时）

的服务时间，而不是该评估期的总服务时间

图 4-9 预测符合性百分比的计算公式

将预测符合性百分比与符合性冲突阈值和危险阈值进行比较，以确定预测符合

性状态（即，预测服务指标处于符合状态、处于危险状态还是处于冲突状态）。

Predicted Compliance Percentage
Expired Service Time Violation Time–( )

Expired Service Time
----------------------------------------------------------------------------------------------------------- 100×=
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符合性
聚集服务指标的符合性状态

对于聚集服务指标，在当前评估期内收集了最终指标之后，才会计算符合性状

态。评估期结束时，计算引擎会将最终指标收集结果的值与符合性阈值和目标

条件进行比较。

聚集服务指标的预测符合性状态

假设在评估期的全部剩余时间内每次后续指标收集将给出相同的结果，符合

性计算将根据最近的指标收集结果，预测当前评估期结束时的聚集服务指标

的符合性状态。

服务的符合性状态

符合性计算将评估服务符合性的以下几个方面：

• 符合性状态

• 预测符合性状态

服务符合性状态

服务的符合性状态被定义为其服务指标的最低符合性状态。例如，如果每个

服务指标的符合性状态都是“危险”，则服务符合性状态也是“危险”。如

果一个服务指标的符合性状态更改为“ 冲突”，则服务符合性状态也更改为

“冲突”。
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预测服务符合性状态

服务的预测符合性状态被定义为其服务指标的最低预测符合性状态。例如，如

果在评估期结束时每个服务指标的符合性状态都预测为“符合”，则服务符合

性状态也预测为相同的符合状态。如果一个服务指标的预测符合性状态下降

到较低的值（例如，危险），则预测服务符合性状态也下降到该值，如图 4-10

中所示。

图 4-10 预测服务符合性状态示例

服务级别协议的符合性状态

符合性计算将评估服务级别协议符合性的以下几个方面：

• 符合性状态

• 预测符合性状态

符合性状态

服务级别协议的符合性状态被定义为与该服务级别协议相关联的服务的最低

符合性状态。例如，如果所有服务当前都是“符合”，则服务级别协议当前也

是“符合”。如果一个服务下降到较低的符合性状态（例如，危险），则服务

级别协议也下降到该符合性状态。

预测符合性状态

服务级别协议的预测符合性状态被定义为与该服务级别协议相关联的服务的

最低预测符合性状态。例如，如果所有服务都预测为“符合”，则服务级别协

议也预测为“符合”。如果一个服务下降到较低的预测符合性状态（例如，危

险），则服务级别协议也下降到该预测符合性状态。
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符合性
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第 5 章 监视可用性和符合性

本章说明 SLM 员工如何监视遵循受管服务级别协议的服务的符合性状态。
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访问监视视图
访问监视视图

用户可以使用标准视图和表单来监视可用性和符合性。

客户关系经理

客户关系经理应访问的服务状态视图是经过过滤的，其中显示了他们所代表

的客户的服务。该视图应该包括以下属性：

• 当前可用性

• 符合性百分比

• 符合性状态

• 预测符合性百分比

• 预测符合性状态

此外，也可以使用资源管理器类型的视图，其中包括应用了与以前相同的过滤

器的导航窗格，以及显示了所选服务的服务指标列表的表视图。

服务经理

服务经理应访问的服务状态视图是经过过滤的，其中显示了他们所负责的服

务。该视图应该包括以下属性：

• 当前基础结构可用性

• 符合性百分比

• 符合性状态

• 预测符合性百分比

• 预测符合性状态

此外，也可以使用资源管理器类型的视图，其中包括应用了与以前相同的过滤

器的导航窗格，以及显示了所选服务的服务指标列表的表视图。
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调查服务基础结构可用性

基础结构可用性是通过基础结构可用性服务指标测量的。如果某项服务基础

结构被测量为不可用，这意味着该服务当前未能遵守其可用性传播规则。这种

情况又可能是由于一个或多个附属服务或已使用的配置项不可用而导致的。

允许某项服务在一段时间内不可用将产生以下后果： 

• 服务接受方无法使用该服务

• 基础结构可用性指标的状态可能是“危险”或“冲突”

要调查服务不可用的原因，应该检查服务层次中每个附属服务和每个配置项

的当前可用性（请参阅第 78 页上的“调查配置项的可用性状态”）。
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调查配置项的可用性状态

如果某个配置项不可用，说明它当前未能遵守以下一个或两个规则： 

• 配置项的可用性传播规则

• 配置项的指标计算规则

要查明不可用情况的原因，请执行以下操作：

首先检查每个配置项指标的目标状态： 

• 如果所有目标都已实现，则说明配置项遵守其指标计算规则，而当前的不

可用情况一定是由于附属配置项不可用而导致的。

• 如果所有目标都未实现，说明配置项未能遵守其指标计算规则。如果指标

计算规则设置为“至少达到一个指标目标”，您应当采取措施至少使一个

指标目标实现。如果指标计算规则设置为“达到所有指标目标”，您应当

采取措施使所有指标目标都实现。

• 如果某些目标未实现而指标计算规则设置为“至少达到一个指标目标”，

说明配置项遵守其指标计算规则，因此不需要执行任何操作。如果某些目

标未实现而指标计算规则设置为“达到所有指标目标”，说明配置项未能

遵守其指标计算规则，因此您应当采取措施使所有指标目标都实现。
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调查服务符合性状态

如果某项服务的符合性状态是“危险”，说明其一个或多个符合性目标的符合

性状态是“危险”。首先请检查服务指标的符合性状态。

如果所有服务指标都符合，请检查基础结构可用性指标的符合性状态。如果该

状态是“危险”，则应该调查服务层次中每个附属服务和每个配置项的当前可

用性状态。
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配置用户对 SLM 报告的访问权限

可以配置 Service Desk，使用户能够通过 OpenView 控制台查看 SLM 报告。

以这种方式查看的报告将显示有关所选的受管服务级别协议、受监控的服务

或配置项的上下文特定信息。

有关如何通过 OpenView 控制台查看 SLM 报告的信息，请参阅 Service Desk 

联机帮助。

有关每个 SLM 报告的说明，请参阅《Service Desk Reporting User Guide》。

本节说明 SLM 报告管理员如何控制用户对 SLM 报告的访问。

SLM 数据仓库模型

“用户”维度将定义与服务级别协议和服务相关联的用户。

• 以下用户与服务级别协议相关联：

— 支付实体（客户业务经理）

— 客户关系经理

• 以下用户与服务相关联：

— 服务经理

— 服务管理员

每当导出 SLM 维度时，将填充“用户”表。（有关如何配置 SLM 维度导出

的信息，请参阅 Service Desk 联机帮助。）定义用户如何与服务级别协议和服

务相关联的映射规则存储在 [dw.configSrv.users] 段的 XPL 配置中，并且可以

进行自定义。

对于服务，当前未提供默认映射。对于服务级别协议，默认映射规则是：

• PayingEntity=Contract.Paid by Person

此映射表示服务级别协议的支付实体由与服务级别协议相关联的“合同”

的“由个人支付费用”属性指定。

• customerRelationshipManager=Contract.To person

此映射表示服务级别协议的客户关系经理由与服务级别协议相关联的

“合同”的“至个人”属性指定。
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在 OpenView 控制台中用户对 SLM 报告的访问权限

可以在以下方面控制用户通过 OpenView 控制台访问 SLM 报告的权限：

• 基于用户角色过滤可访问的报告（第 83 页）

• 过滤报告数据（第 83 页）

基于用户角色过滤可访问的报告

用户通过 OpenView 控制台访问的 SLM 报告可以根据用户的角色（即，用户当

前登录到 OpenView 控制台时使用的角色）进行配置。通常，应使支付机构有权

访问基于合同的报告，如 SLA 概览、SLA 详细信息、SLO 概览等，而服务经理

应有权访问基础结构报告，如服务概览、服务详细信息、配置项详细信息等。

角色与可以访问的每个对象类型（服务级别协议、服务和配置项）的报告列

表之间的关联是由通过 OpenView 控制台进行管理的 OVPI 报告对象定义的。

该关联由多组参数和值组成，以指定以下内容：

• 报告标识和参数。

• 对象类型。

• 可以访问报告的用户角色列表。

• 启动报告的系统操作名称。这是用户导航至相关对象类型的工作区并访问

“操作”菜单时，向用户显示的命令名称。

过滤报告数据

通过 OpenView 控制台显示的 SLM 报告中的数据可以根据当前登录到 

OpenView 控制台的用户进行过滤。通常，在 SLA 概览报告中应该仅列出与

支付实体相关联的服务级别协议。

通过在启动报告时指定参数来过滤报告中所包含的数据。预先配置的 SLM 

报告当前支持两个参数：

• 目标实体 OID（例如，要包括在 SLA 详细信息报告中的服务级别

协议的 OID）

• 用户 OID（例如， SLA 概览报告的支付实体的 OID 或服务概览报告的

服务经理的 OID）

通过在启动报告时传递适当的参数和值，系统将根据该参数值来过滤报告的

内容。如果未指定值，则不会执行任何过滤。
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例如：

• 如果在启动 SLA 详细信息报告时指定了服务级别协议 OID 参数，则报告
中仅显示与指定的服务级别协议相关的信息。如果没有为此参数指定任何
值，报告将包括与所有服务级别协议相关的详细信息。

• 如果在启动 SLA 概览报告时指定了用户 OID 参数，则报告仅包括与指定
的服务级别协议（其指定用户为支付实体）相关的信息。如果没有为此参
数指定任何值，报告将包括所有服务级别协议。

SLM 报告映射

本节介绍在 SLM 报告中进行报告映射所需的 OVPI 报告对象的属性，SLM 报
告可通过 OpenView 控制台访问。管理员可以自定义和扩展属性值。

在特定对象类型的工作区上下文中启动报告的每个系统操作都是在特定的 OVPI
报告对象（例如，名称为 SLM:CI Detail）中指定的。在本示例中，报告显示进
行可用性和符合性计算的配置项的详细信息。

OVPI 报告对象的属性定义在要启动的报告、用户角色和所报告的目标实体之
间的映射。

表 6-1 描述了 OVPI 报告对象类型的属性：

表 6-1 OVPI 报告属性

属性 说明

文件名 报告名称（在 OVPI 中定义）

目录 报告路径（在 OVPI 中定义）

操作名 “操作”菜单中显示的报告启动命令

名称 在报告窗口的标题中显示的报告名称

目标实体 为其添加“操作”菜单上的命令的对象类型

角色 允许启动报告的角色列表

注： 如果未指定此参数，每个用户都可以访问报告，

而不考虑角色。

参数 在报告启动时要传递给报告系统的 OVPI 报告参数。

OVPI_REPORT_PARAM=[%u | %e]

• %u： 在控制台中登录的用户的 OID

• %e： 所选对象的 OID
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SLM 报告映射示例

本节包含报告设置示例，用于说明如何控制通过 OpenView 控制台对 SLM 

报告的访问。

• 系统管理员可以打开 SLA 概览报告，并可以查看所有服务级别协议：

图 6-1 针对系统管理员的 SLA 概览报告
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• 客户业务经理可以打开 SLA 概览报告，并可以查看与关联的服务级别

协议有关的信息：

图 6-2 针对支付实体的 SLA 概览报告
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• 系统管理员和客户业务经理可以打开 SLA 详细信息报告，并可以查看所

选服务级别协议的详细信息：

图 6-3 针对系统管理员和支付实体的 SLA 详细信息报告
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以 PDF 和 SREP 格式生成 SLM 报告

您可以使用标准 OVPI 功能生成静态版本的 SLM 报告（有关详细信息，请参

阅 OVPI 文档）。以 PDF 格式生成静态报告时，报告系统将浏览所有追溯组合

并为每个组合生成一个页面。由于预先配置的 SLM 报告是交互式的，可能导

致生成较大的 PDF 文档。因此，可以有选择性地以 PDF 和 SREP 格式生成特

定的 SLM 报告。这些版本以《Service Desk Reporting User Guide》中描述的

SLM 报告为基础，但包含较少的追溯选项，因此可生成较小的静态输出文件。

可以在 Performance Insight 标准查看器或 Web 访问服务器中的“SLM 
Reporting/Static”文件夹中找到静态版本的 SLM 报告。表 6-2 列出了可

用的报告类别：

表 6-2 静态 SLM 报告的类别

类别 可用报告 图形的时间段 数据粒度

每小时 所有基础结构报告（服务

概览、服务详细信息和配置

项详细信息）

前一个小时 每五分钟

每日 所有基础结构报告 前一天 每小时

每周 所有基础结构报告 前一周 每日

每月 所有基础结构报告 前一个月 每日

评估期 所有基于 SLA 的报告

（SLA 概览、 SLA 详细

信息、SLO 详细信息和服务

详细信息）

前一个 SLA 评估期 每日
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自定义静态报告时间段

对于除评估期之外的所有静态报告类别，您可以为图形自定义时间段。自定义

时间段的方式取决于报告访问方法。

OVPI 标准查看器

1. 右击图形。

2. 选择“设置时间段 ...”。

3. 在对话框中指定所需的时间段。

OVPI Web 服务器

1. 在图形的右上角，单击“编辑图形”图标。

2. 在对话框中指定所需的时间段。

注释 只有在启用元素编辑时，才显示“编辑图形”图标。要启用元素编辑，请在

浏览器的右上角，单击“首选项”菜单，展开“部署项”，单击“视图”，

然后选中“允许元素编辑”复选框。

在 OpenView 控制台中查看静态报告

OpenView 控制台当前不支持对静态 SLM 报告的访问。
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第 7 章 SLM 方案

本章介绍了说明 Service Level Manager 实用功能的各种方案。
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方案 1：指标配置和发现

本方案说明了 SLM 管理员配置指标适配器和执行指标发现的过程。假设所有

必需的产品组件都已安装。

SLM 管理员从服务级别经理那里收到一个请求，要求提供以下 OVIS 

(HP OpenView Internet Services) 测量类型： 

• ICMP（测量特定配置项的可用性）

• HTTP（测量 Web 服务的可用性和提供特定网页的响应时间）

配置指标适配器

在安装有 OVIS 的主机上安装 OVIS 指标适配器后， SLM 管理员必须配置该

指标适配器。这可以通过编辑 <installation directory>\data\conf\
OvisMA.xml 文件来完成。

图 7-1 显示了配置文件的初始内容。以粗体显示的文本字符串需要替换为特定

于安装产品的值。表 7-1 列出了必须提供的值。

图 7-1 配置文件的初始内容

<?xml version="1.0" encoding="UTF-8"?>

<Config>

    <MA name="OvisMA">

        <Publisher.APP_NAME>OvisMAPublisher</Publisher.APP_NAME>

        <DefaultTaskPollingPeriod>300</DefaultTaskPollingPeriod>

        <DataPointVersionByte>1</DataPointVersionByte>

        <ServerHost>$SLM_HOSTNAME$</ServerHost>

        <TypeByte>1</TypeByte>

        <isEventBased>0</isEventBased>

        <SequenceNumber>0</SequenceNumber>

        <Publisher.RESPONSE_TIMEOUT>60</Publisher.RESPONSE_TIMEOUT>

        <DiscoveryInterval>3600</DiscoveryInterval>

        <MrpDefinitionDiscoveryInterval>86400</MrpDefinitionDiscoveryInterval>
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        <HeartBeatsInterval>300</HeartBeatsInterval>

        <DefaultTaskExpirePeriod>600</DefaultTaskExpirePeriod>

        <DataPointSynchronizationDelay>600</DataPointSynchronizationDelay>

    </MA>

    <Connector name="$OVIS_HOSTNAME$">

        <Timeout>10</Timeout>

        <DiscoveryMaxHistory>10080</DiscoveryMaxHistory>

        <CryptedPassword>FIrnif9Zv5nLaM+F/q5/QA==</CryptedPassword>

        <Host>$OVIS_HOSTNAME$</Host>

        <Class>com.hp.ov.sd.slm.sa.ovis.Connector</Class>

        <URL>jdbc:inetdae7:$OVIS_HOSTNAME$:$OVIS_PORT$</URL>

        <DBName>reporter</DBName>

        <DriverName>com.inet.tds.TdsDriver</DriverName>

        <Table>IOPS_DETAIL_DATA</Table>

        <Port>$OVIS_PORT$</Port>

        <Login>openview</Login>

        <nbReconnection>10</nbReconnection>

    </Connector>

    <DiscoveryLocationFilter>

        <All/>

    </DiscoveryLocationFilter>

</Config>
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SLM 管理员需要替换配置文件中的以下默认文本字符串：

为了确定正确的 OVIS_PORT 值， SLM 管理员将运行以下应用程序： 
C:\Program Files\Microsoft MS SQL Server\80\Tools\Binn\

SVRNETCN.exe。正确的端口号显示在 TCP/IP 属性对话框中：

图 7-2 确定正确的 OVIS 端口

表 7-1

默认文本字符串 替换的文本字符串

$SLM_HOSTNAME SLM 服务器的主机名或 IP 地址。

$OVIS_HOSTNAME OVIS 服务器的主机名或 IP 地址。

$OVIS_PORT 连接到 OVIS 数据库的端口号。
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在本方案中，SLM 服务器进程在名为 SLM 的主机上运行，OVIS 主机设置为

LOCALHOST（因为 OVIS 与 OVIS 指标适配器安装在同一台主机上），并且

所需的 OVIS 端口号标识为 1151（请参阅图 7-2）。

为了应用这些值， SLM 管理员将在命令行提示符后运行以下命令，以启动指

标适配器配置实用程序：

<install_dir>\bin\startMAConfigGui.bat

此时将显示“共享参数”选项卡页。SLM 管理员将在“值”字段中键入 SLM

服务器的主机名，指示安装在此服务器上的每个指标适配器必须将指标数据

值发送给指定的 SLM 服务器：

图 7-3 指标适配器配置实用程序（“共享参数”）
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SLM 管理员单击“OvisMA”选项卡页，然后为 OVIS 主机名和端口键入正确

的值。更新后的配置文件将显示在相邻的“XML”面板中：

图 7-4 指标适配器配置实用程序（“OvisMA 参数”）
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最后， SLM 管理员单击“全部保存”，然后单击“文件”→“退出”，以保

存这些设置并关闭该实用程序。图 7-5 显示了编辑后的 OVIS 指标适配器的配

置文件：

图 7-5 编辑后的配置文件

<?xml version="1.0" encoding="UTF-8"?>

<Config>

    <MA name="OvisMA">

        <Publisher.APP_NAME>OvisMAPublisher</Publisher.APP_NAME>

        <DefaultTaskPollingPeriod>300</DefaultTaskPollingPeriod>

        <DataPointVersionByte>1</DataPointVersionByte>

        <ServerHost>SLM</ServerHost>

        <TypeByte>1</TypeByte>

        <isEventBased>0</isEventBased>

        <SequenceNumber>0</SequenceNumber>

        <Publisher.RESPONSE_TIMEOUT>60</Publisher.RESPONSE_TIMEOUT>

        <DiscoveryInterval>3600</DiscoveryInterval>

        <MrpDefinitionDiscoveryInterval>86400</MrpDefinitionDiscoveryInterval>

        <HeartBeatsInterval>300</HeartBeatsInterval>

        <DefaultTaskExpirePeriod>600</DefaultTaskExpirePeriod>

        <DataPointSynchronizationDelay>600</DataPointSynchronizationDelay>

    </MA>

    <Connector name="LOCALHOST">

        <Timeout>10</Timeout>

        <DiscoveryMaxHistory>10080</DiscoveryMaxHistory>

        <CryptedPassword>FIrnif9Zv5nLaM+F/q5/QA==</CryptedPassword>

        <Host>LOCALHOST</Host>

        <Class>com.hp.ov.sd.slm.sa.ovis.Connector</Class>

        <URL>jdbc:inetdae7:LOCALHOST:1151</URL>

        <DBName>reporter</DBName>

        <DriverName>com.inet.tds.TdsDriver</DriverName>
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        <Table>IOPS_DETAIL_DATA</Table>

        <Port>1151</Port>

        <Login>openview</Login>

        <nbReconnection>10</nbReconnection>

    </Connector>

    <DiscoveryLocationFilter>

        <All/>

    </DiscoveryLocationFilter>

</Config>

抑制初始指标发现

为了抑制初始指标发现， SLM 管理员需要在文本编辑器中打开以下文件： 

<HP OpenView installation directory>/misc/xpl/config/
defaults/slm.ini

在包含字符串“bool OvisMAdiscoverAll=true”的行中，SLM 管理员将

“OvisMAdiscoverAll”参数的值从“true”更改为“false”。

现在， SLM 管理员已准备好在 OpenView 控制台中登记指标适配器并触发指标

定义发现。

触发指标定义发现

为了在 OpenView 控制台中登记指标适配器并触发指标定义发现， SLM 管理

员将首先启动 SLM 服务器在命令行提示符后运行以下命令：

ovc -start ovsdslm

现在， SLM 管理员启动 OVIS 指标适配器：

ovc -start ovisma
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SLM 管理员导航至“OVIS 指标定义”工作区，确认指标定义发现过程已创建

了代表在 OVIS 中配置的探测器的对象：

图 7-6 发现的 OVIS 指标定义
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触发指标发现

既然已发现指标定义，SLM 管理员就可以配置指标发现过滤并触发指标发现。

要执行上述操作，必须将指标适配器与发现过滤器（指定要发现其指标的指

标定义）相关联。

SLM 管理员在表单中打开 OVIS 指标适配器对象，然后在“发现过滤器”

面板中单击“新建”按钮：

图 7-7 将发现过滤器与指标适配器相关联
第 7 章100



SLM 方案

方案 1：指标配置和发现
在“发现过滤器”表单中，SLM 管理员在“指标定义”面板中单击“关联”

按钮：

图 7-8 将指标定义与发现过滤器相关联
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在“高级查找”对话框中， SLM 管理员指定一个用于搜索所有 ICMP 指标定

义的搜索标准，在搜索结果面板中选择它们，然后单击“选择”按钮：

图 7-9 选择 ICMP 指标定义
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现在，所选的指标定义都在发现过滤器中列出：

图 7-10 与发现过滤器相关联的所选指标定义

SLM 管理员以同样方式创建另一个发现过滤器，该发现过滤器包括测量响应

时间的所有 OVIS 指标定义：

图 7-11 响应时间指标的发现过滤器
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通过将一个附加发现过滤器与指标适配器相关联（请参阅图 7-12）， SLM 管

理员可以增加发现的范围。触发指标发现后，将会发现与包括在任何发现过滤

器中的任何指标定义相关联的所有指标。

图 7-12 添加了两个发现过滤器之后的指标适配器

现在， SLM 管理员重新启动 OVIS 指标适配器在命令行提示符后运行以下

命令。此操作将触发指标发现过程：

ovc -restart ovisma
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SLM 管理员导航至“OVIS 指标”工作区，确认指标发现过程已创建代表特

定的指标数据值的源的对象：

图 7-13 发现的 OVIS 指标

请注意，发现的指标比指标定义要少。这种差异是应用指标发现过滤器的

结果。
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SLM 方案

方案 2：设计服务定义
方案 2：设计服务定义

此方案说明适合在 Service Level Manager 中使用的服务定义的创建过程。

第 137 页上的“方案 3：基于服务定义创建受监视服务”说明基于此服务定

义创建受监视服务的过程。

建立服务定义层次

服务设计人员建立服务定义层次时，应首先考虑服务定义层次中的相关性。

服务设计人员将考虑以下问题：

• 对于符合性和可用性，需要监视哪些服务组件？

• 服务是否依赖其它部门或组织提供的附属服务？

• 所有组件如何彼此依赖？

在本方案中，服务设计人员计划为 Web 服务设计服务定义。Web 服务包括负载

平衡的 Web 服务器前端、后台数据库以及至少包括一个 Web 服务器的 Web 服

务器场。在本示例中，数据库组件是由同一组织内的另一个部门提供的服务。
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SLM 方案

方案 2：设计服务定义
服务设计人员访问“服务定义”工作区，在视图中右击，然后选择用于创建

新服务定义的命令： 

图 7-14 创建服务定义
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SLM 方案

方案 2：设计服务定义
新的服务定义将在表单中打开。虽然可以在表单中输入诸如说明等基本详细

信息，但是，在此阶段只指定名称已足够了。服务设计人员还将选择要求所有

已用组件均处于可用状态的可用性传播规则： 

图 7-15 服务定义的基本详细信息
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SLM 方案

方案 2：设计服务定义
服务设计人员保存新服务定义并切换到“服务定义层次”选项卡页时，将显

示当前的服务定义层次。在此阶段，该层次仅包括服务定义本身。服务设计人

员在该层次中右击，然后选择用于添加表示负载平衡器的配置项定义的命令：

图 7-16 初始服务定义层次

此时将显示以下对话框：

图 7-17 “配置项定义关系”对话框
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SLM 方案

方案 2：设计服务定义
服务设计人员单击“配置项定义”字段旁边的“快速查找”按钮。此时将出现

“快速查找”对话框，显示可用配置项定义列表。由于负载平衡器定义尚未创

建，因此，服务设计人员在“对象”列表中右击，然后选择用于创建新配置项

定义的命令： 

图 7-18 创建负载平衡器
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SLM 方案

方案 2：设计服务定义
服务设计人员将在表单中提供负载平衡器定义的基本详细信息，然后保存该

定义：

图 7-19 指定负载平衡器基本详细信息

在“快速查找”对话框中，服务设计人员现在可以在列表中选择负载平衡器

定义：

图 7-20 选择负载平衡器
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SLM 方案

方案 2：设计服务定义
服务设计人员确认该配置项定义关系设置：

图 7-21 确认定义关系设置

该负载平衡器配置项定义会自动添加到服务定义层次中：

图 7-22 包括负载平衡器的服务定义层次

表示 Web 服务器场的配置项定义也以同样方式进行添加。为 Web 服务器场选

择的可用性传播规则要求至少一个已使用的组件（在本示例中为 Web 服务器）

处于可用状态： 

图 7-23 Web 服务器场配置项定义
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SLM 方案

方案 2：设计服务定义
服务设计人员现在执行用于将 Web 服务器与 Web 服务器场相关联的命令：

图 7-24 包括 Web 服务器场的层次

在出现的对话框中，服务设计人员将选择多重性范围“1...*”。这表示基于此

服务定义的服务层次必须至少包括一个 Web 服务器配置项，但可以包括的最

多数量不限。所需的配置项定义在“至”字段中进行选择。服务设计人员选

择关系类型“使用”： 

图 7-25 将 Web 服务器作为已用的配置项定义进行添加

下图显示了到目前为止创建的服务定义层次：

图 7-26 添加了 Web 服务器的服务定义层次
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SLM 方案

方案 2：设计服务定义
最后，服务设计人员执行用于添加已用的服务定义代表由其它部门提供的数

据库服务的命令：

图 7-27 添加已用的服务定义

由于已用的服务定义尚不存在，因此，服务设计人员在“快速查找”对话框

中右击，然后选择创建服务定义的命令：

图 7-28 选择已用的服务定义
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SLM 方案

方案 2：设计服务定义
如果保存了服务定义及其指定的基本详细信息，服务设计人员就可以在

“快速查找”对话框中选择它。已完成的服务定义层次显示在下图中：

图 7-29 已完成的服务定义层次
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SLM 方案

方案 2：设计服务定义
添加指标定义

服务设计人员现在考虑应如何测量基于层次中定义的对象。服务设计人员可

以使用指标发现过程所发现的任何指标定义。此外，服务设计人员还可以使用

任何手动创建的 OVSD 指标定义，这些指标定义用于测量服务性能的各个方

面，包括 MTBF（平均无故障时间）。

负载平衡器将通过 OVIS ICMP 可用性指标定义进行测量。服务设计人员单击

层次中的负载平衡器配置项定义，然后选择用于编辑它的命令：

图 7-30 编辑负载平衡器
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SLM 方案

方案 2：设计服务定义
在配置项定义表单中，服务设计人员导航至列出指标定义的选项卡页，然后

单击“新建”按钮，添加新的配置项指标定义：

图 7-31 显示配置项指标定义列表

在“配置项指标定义”表单中，服务设计人员单击“指标定义”字段旁边的

“快速查找”按钮：

图 7-32 打开用于选择指标定义的对话框
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SLM 方案

方案 2：设计服务定义
此时将打开“快速查找”对话框。在“对象类型”字段中，服务设计人员选

择所需的指标定义类型，然后从列表中选择 OVIS ICMP 可用性指标定义： 

图 7-33 选择“可用性 /ICMP”指标定义
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SLM 方案

方案 2：设计服务定义
该配置项指标定义将添加到列表中：

图 7-34 “可用性 /ICMP”指标定义已添加到表单中

服务设计人员重复同一过程来添加 OVIS HTTP 可用性指标定义，以测量 Web

服务器。

服务设计人员选择不为 Web 服务器场添加指标定义。基于此定义的配置项将

根据其可用性传播规则计算可用性，它们的可用性传播规则设置为“至少有

一个子级可用”（请参阅图 7-23）。只要一个 Web 服务器可用，即认为该 Web

服务器场可用。

服务层次中的辅助显示将确认除 Web 服务器场之外的所有配置项定义都添加

了指标定义：

图 7-35 添加了指标定义的定义层次
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SLM 方案

方案 2：设计服务定义
下一步是指定如何测量服务定义本身。作为服务定义创建过程的一部分，基础

结构可用性指标定义会自动添加： 

图 7-36 显示服务指标定义列表

此外，服务设计人员还决定使用“OVIS HTTP 响应时间”指标定义，该指标

定义的添加方式与配置项指标定义的添加方式相同。
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SLM 方案

方案 2：设计服务定义
服务设计人员还决定使用用于测量平均无故障时间的服务台指标，然后单击

“新建”按钮，在表单中打开新的服务指标定义：

图 7-37 添加 OVSD 服务指标定义
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SLM 方案

方案 2：设计服务定义
在服务指标定义表单中，服务设计人员单击“指标定义”字段旁边的“快速

查找”按钮： 

图 7-38 打开用于选择指标定义的对话框
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SLM 方案

方案 2：设计服务定义
此时将打开“快速查找”对话框。在“对象类型”字段中，服务设计人员选

择要使用的指标定义类型。由于目前尚未定义任何服务台指标定义，因此，

服务设计人员在“对象”面板中右击，然后选择用于创建新指标定义的命令： 

图 7-39 创建 MTBF 指标定义
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SLM 方案

方案 2：设计服务定义
新的 OVSD 指标定义将在表单中打开。服务设计人员提供名称，选择“平均

无故障时间”作为指标类型，并选择定义测量类型的基础的其它选项：

图 7-40 “OVSD 指标定义”表单

服务设计人员保存该指标定义，关闭表单；现在可以在“快速查找”对话框

中显示的列表中选择该指标定义： 

图 7-41 选择 MTBF 指标定义
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SLM 方案

方案 2：设计服务定义
所选的服务指标定义显示在列表中。图 7-42 显示了三个服务指标定义：

图 7-42 OVSD 服务指标定义已添加到列表中
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SLM 方案

方案 2：设计服务定义
在此阶段，服务定义层次已建立，并且在除 Web 服务器场之外的整个层次中

都指定了指标定义（请参阅第 116 页上的“添加指标定义”一节中的说明）。

图 7-43 指定了指标定义的层次
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SLM 方案

方案 2：设计服务定义
添加服务级别

为了满足客户对不同服务质量的要求，服务设计人员决定提供三种不同服务级

别的 Web 服务： 金牌、银牌和铜牌。

服务设计人员导航至列出与服务定义相关联的服务级别的选项卡页，然后单击

“新建”按钮：

图 7-44 添加服务级别
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SLM 方案

方案 2：设计服务定义
在“服务级别”表单中，系统会使用关联的服务定义自动预先填写“服务

定义”字段。服务设计人员为服务级别提供名称，然后保存它：

图 7-45 提供服务级别的基本详细信息

服务设计人员依次为每个服务级别重复该任务。图 7-46 显示了已与服务定义

相关联的服务级别：

图 7-46 服务级别
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SLM 方案

方案 2：设计服务定义
添加可用性目标

现在，服务设计人员决定要添加哪些可用性目标。“可用性 SLO”表最初显

示一个空的目标表。在该表中，每个已添加的服务级别各占一列（请参阅

第 127 页上的“添加服务级别”），每个配置项指标定义各占一行（请参阅

第 116 页上的“添加指标定义”）。指标定义按其对应的配置项定义进行了

分组：

图 7-47 “可用性 SLO”表

由于 OVIS ICMP 和 HTTP 可用性指标将返回值 0 或 1，因此，服务设计人员

决定为每个指标定义指定“大于或等于”目标运算符，并指定值为 1。选择

“大于”运算符和值 0.5 将具有同样效果： 

• 如果收到指标数据值 1，则目标已实现

• 如果收到指标数据值 0，则目标尚未实现
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SLM 方案

方案 2：设计服务定义
服务设计人员从“运算符”列的下拉列表中选择所需的运算符：

图 7-48 选择可用性目标运算符

服务设计人员在每个表单元格中键入目标值：

图 7-49 指定目标值

下图显示了添加了所有运算符和值的表： 

图 7-50 已完成的“可用性 SLO”表
第 7 章130



SLM 方案

方案 2：设计服务定义
添加符合性目标

现在，服务设计人员开始指定符合性目标。可以为每个服务级别指定不同的符合

性标准。如果某个表单元格为指标和服务级别的特定组合保留空白，该指标将从

符合性计算中排除。服务设计人员为 Web 服务定义选择以下符合性计算方案：

• 金牌服务级别提供的服务必须达到所有三个指标（基础结构可用性、

OVIS HTTP 响应时间和 OVSD MTBF）的目标。

• 银牌服务级别提供的服务必须达到基础结构可用性和 OVIS HTTP 响应时

间指标的目标。在符合性计算中将忽略 OVSD MTBF 指标。

• 铜牌服务级别提供的服务必须达到基础结构可用性指标的目标。在符合性

计算中将忽略 OVIS HTTP 响应时间指标和 OVSD MTBF 指标。

最初，“符合性 SLO”选项卡页为自动创建的基础结构可用性指标显示预定义

的符合性目标阈值。需要指定 OVIS HTTP 响应时间指标和 OVSD MTBF 指标

的目标运算符和值。

服务设计人员从“运算符”列的下拉列表中选择运算符。如果是 OVIS HTTP

响应时间指标，运算符“小于或等于”是适用的。这意味着如果测量的响应

时间小于其目标阈值，则目标状态为“已实现”：

图 7-51 选择符合性目标运算符
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SLM 方案

方案 2：设计服务定义
对于 OVSD MTBF 指标，运算符“大于或等于”是适用的。这意味着如果两

次故障之间测量的平均时间大于其目标阈值，则目标状态为“已实现”。

服务设计人员在每个表单元格中直接键入目标阈值。为每个服务级别指定不

同的值：

图 7-52 输入符合性目标值

现在，服务设计人员指定符合性冲突阈值。

对于基础结构和标准指标定义，符合性冲突阈值将指定实现目标状态所需的

最小时间百分比（与评估期内的总服务时间相比）。如果违反了百分比阈值，

即违反了目标的符合性状态。

对于聚集指标定义，如 OVSD MTBF，冲突阈值与目标状态阈值完全相同，但

是，运算符相反。例如，如果 OVSD MTBF 目标值为 80 小时并且运算符为

“大于”，则冲突阈值会自动设置为 80，而运算符会自动设置为“小于”。与

此相反，如果 OVSD MTTR（平均修复时间）目标值为 2 小时并且运算符为

“小于”，则冲突阈值会自动设置为 2，而运算符会自动设置为“大于”。
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SLM 方案

方案 2：设计服务定义
服务设计人员从金牌服务级别的基础结构可用性指标开始，双击“符合性阈

值”表中的相关单元格：

图 7-53 访问“符合性阈值”表单

此时将打开“符合性服务级别目标”表单。为了指定冲突阈值，服务设计人员

单击阈值列表中的“新建”按钮：

图 7-54 添加符合性冲突阈值
第 7 章 133



SLM 方案

方案 2：设计服务定义
此时将打开“符合性阈值”表单。在定义符合性冲突阈值之前，不允许服务

设计人员指定危险阈值。服务设计人员指定值 95%：

图 7-55 输入冲突阈值

服务设计人员指定危险阈值为 98%，并且选择严重性“警告”。可以指定其它

危险阈值，每个阈值有不同的百分比值和程度代码。

图 7-56 输入危险阈值
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SLM 方案

方案 2：设计服务定义
图 7-57 显示了已完成的“符合性服务级别目标”表单。如果在评估期内服务

时间的 2% 未能达到可用性目标，则基础结构可用性目标的符合性状态将下降

到危险。如果在服务时间的 5% 未能达到目标，将违反基础结构可用性目标。

这将足够导致违反服务的符合性状态。

图 7-57 已完成的“符合性服务级别目标”表单
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SLM 方案

方案 2：设计服务定义
对于其指标将参与符合性计算的每个指标和服务级别的组合，将重复指定冲突

和危险阈值的过程（请参阅本节第 131 页上的“添加符合性目标”开始部分

的符合性计算方案的说明）：

图 7-58 已完成的“符合性 SLO”表

服务设计人员保存并关闭服务定义。服务经理现在可以使用该服务定义来

创建受监视服务（请参阅第 137 页上的“方案 3：基于服务定义创建受监视

服务”）。
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SLM 方案

方案 3：基于服务定义创建受监视服务
方案 3：基于服务定义创建受监视服务

本方案说明服务经理如何基于在第 106 页上的“方案 2：设计服务定义”中创

建的 Web 服务的服务定义来创建受监视服务。

指定 SLA 详细信息

服务经理从为已用的数据库服务创建新的服务级别协议开始：

图 7-59 为已用的服务创建新的服务级别协议
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理为数据库服务选择服务定义，然后选择金牌服务级别：

图 7-60 SLA 的基本详细信息
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理导航至关联服务列表，然后单击“新建”按钮创建新服务：

图 7-61 创建新的数据库服务
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SLM 方案

方案 3：基于服务定义创建受监视服务
在服务表单中，服务经理指定基本详细信息：

图 7-62 服务的基本详细信息
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SLM 方案

方案 3：基于服务定义创建受监视服务
保存服务后，这些信息会自动添加到关联服务列表中：

图 7-63 SLA 中列出的数据库服务
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理现在基于 Web 服务定义为 Web 服务创建新的服务级别协议。客户对

Web 服务的金牌级服务级别感兴趣：

图 7-64  Web 服务的 SLA
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SLM 方案

方案 3：基于服务定义创建受监视服务
要提供给客户的 Web 服务已创建，并同与 SLA 相同的服务定义相关联：

图 7-65 Web 服务的基本详细信息

服务经理现在开始将层次中的每个定义替换为服务或配置项。
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SLM 方案

方案 3：基于服务定义创建受监视服务
替换定义

最初，服务层次显示从服务定义层次继承的定义。由红色实线连接的每个定义

必须替换为服务或配置项：

图 7-66 初始服务层次
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理右击连接服务与数据库服务定义的连线，然后选择用于关联服务的

命令：

图 7-67 替换数据库服务定义

在“快速查找”对话框中，服务经理选择要替换服务定义的服务：

图 7-68 选择数据库服务
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务层次在数据库服务定义的位置自动显示替代它的数据库服务，并且连接线

从红色变为黑色：

图 7-69 层次中显示的数据库服务

服务经理右击连接服务与负载平衡器配置项定义的连线，然后选择用于关联

配置项的命令：

图 7-70 替换负载平衡器配置项定义
第 7 章146



SLM 方案

方案 3：基于服务定义创建受监视服务
“快速查找”对话框显示一个空列表，指示基于负载平衡器定义的配置项当前

不存在。服务经理在该对话框中右击，然后选择用于创建新配置项的命令：

图 7-71 创建负载平衡器配置项
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SLM 方案

方案 3：基于服务定义创建受监视服务
在配置项表单中，服务经理提供有关配置项的基本详细信息，将其与正确的

定义相关联，然后保存：

图 7-72 负载平衡器的基本详细信息
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SLM 方案

方案 3：基于服务定义创建受监视服务
在“快速查找”对话框中，服务经理选择新创建的配置项：

图 7-73 选择负载平衡器配置项

服务层次在配置项定义的位置自动显示替代它的配置项：

图 7-74 层次中显示的配置项
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理以同样方式将 Web 服务器场定义替换为配置项：

图 7-75 层次中显示的 Web 服务器场配置项

服务经理替换 Web 服务器配置项定义时，该定义的图标将保留在层次中。多重

性指示器将从“1...*”变为“0...*”，并且红色实线将替换为黑色虚线，表明

可以将 Web 服务器定义替换为其它配置项，但并不必要。在本实例中，服务

经理决定不添加其它 Web 服务器。现在，所有定义均替换为服务和配置项： 

图 7-76 包含一个 Web 服务器配置项的层次
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SLM 方案

方案 3：基于服务定义创建受监视服务
指定指标源

服务经理现在已准备好指定用于定义指标数据值的源的指标。每个服务指标

（除了自动创建的基础结构可用性指标）和服务层次中的每个配置项指标都需

要执行此操作。

OVIS、OVPM 和 OVSN 指标是指标发现的结果（请参阅第 92 页上的“方案 1：

指标配置和发现”）。OVSD 指标通常是手动创建的。

为了指定服务指标的指标源，服务经理导航至显示“符合性 SLO”表的选项

卡页。服务经理双击 OVIS HTTP 响应时间指标名称：

图 7-77 访问服务指标的指标源列表
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理从列表中显示的指标中进行选择。这些指标是指标发现过程的结果，

以供选择（请参阅第 92 页上的“方案 1：指标配置和发现”）：

图 7-78 从列表中选择指标数据源

指标阈值表中的辅助显示会进行更新，指明 OVIS HTTP 响应时间指标已配置，

但是仍需配置 OVSD MTBF 指标：

图 7-79 已更新的“指标阈值”表
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SLM 方案

方案 3：基于服务定义创建受监视服务
配置 OVSD MTBF 指标之前，必须配置 MTBF 数据的收集和计算。服务经理

在表单中打开服务级别协议，导航至列出服务台指标的选项卡页，然后单击

“新建”按钮创建新指标：

图 7-80 SLA 中的服务台指标
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SLM 方案

方案 3：基于服务定义创建受监视服务
此时将打开“OVSD 指标”表单。服务经理将该指标与服务定义创建过程

（请参阅第 106 页上的“方案 2：设计服务定义”）中创建的 MTBF 指标定义

相关联，并提供基本详细信息，如名称。所选的每日重复调度将指定每日收集

和计算 MTBF 数据。每次收集都是累计的，从评估期开始的那一刻开始计算：

图 7-81 指定 OVSD 指标收集的详细信息
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SLM 方案

方案 3：基于服务定义创建受监视服务
所创建的指标添加到服务级别协议的服务台指标列表中：

图 7-82 SLA 中列出的 OVSD 指标

服务经理现在可以配置 OVSD MTBF 指标源。返回到服务表单中的指标阈值表，

服务经理双击该指标名称：

图 7-83 指定 OVSD MTBF 指标源
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理从列表中选择 OVSD 指标：

图 7-84 选择 OVSD MTBF 指标
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SLM 方案

方案 3：基于服务定义创建受监视服务
指标阈值表中的辅助显示进行更新，指明所有指标都已配置：

图 7-85 已完成的“符合性 SLO”表
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SLM 方案

方案 3：基于服务定义创建受监视服务
为了指定配置项指标的指标源，服务经理首先导航至显示“可用性 SLO”表

的选项卡页，然后双击指标名称：

图 7-86 访问配置项指标的源列表
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理从列表中显示的指标中进行选择：

图 7-87 从列表中选择指标数据源

“可用性 SLO”表中的辅助显示将自动更新，指明负载平衡器的可用性指标已

配置：

图 7-88 已更新的可用性目标表
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理对其它可用性目标重复该过程：

图 7-89 已完成的可用性目标表

服务层次中的辅助显示将确认层次中的所有对象都符合其定义，并且所有指标

都已完全配置：

图 7-90 完全配置的层次
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SLM 方案

方案 3：基于服务定义创建受监视服务
管理服务级别协议

本方案中的最后步骤是将服务级别协议置于 SLM 管理之下。在服务表单中，

服务经理在生存期、管理、活动和层次状态字段中选择适当的值：

图 7-91 管理服务
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SLM 方案

方案 3：基于服务定义创建受监视服务
需要将服务级别协议的生存期状态更新为映射到“受管”管理状态的值：

图 7-92 管理服务级别协议
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SLM 方案

方案 3：基于服务定义创建受监视服务
服务经理导航至“服务状态”工作区。受监视服务已自动添加到列表中。这将

证实该服务在 SLM 管理之下。 SLA 开始日期到来时，符合性和可用性计算会

自动开始：

图 7-93 查看受管服务的状态
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SLM 方案

方案 4：创建层次过滤器
方案 4：创建层次过滤器

此方案说明层次过滤器的创建过程。第 180 页上的“方案 5：基于层次过滤器

创建受监控服务”说明基于层次过滤器创建受监视服务的过程。两个方案都假

设包含关联服务和配置项的 CMDB 已存在。

输入层次过滤器的基本详细信息

服务设计人员访问“层次过滤器”工作区，在视图中右击，然后选择用于创建

新层次过滤器的命令： 

图 7-94 创建新层次过滤器
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SLM 方案

方案 4：创建层次过滤器
在表单中，服务设计人员必须首先在层次的顶部指定对象的类型。在本方案

中，层次必须有一个服务作为其根对象。服务设计人员单击“根对象”字段

旁边的“快速查找”按钮，然后从对象列表中选择“服务”：

图 7-95 指定根对象类型
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SLM 方案

方案 4：创建层次过滤器
服务设计人员指定其它基本详细信息，如过滤器的名称。在“预览根对象”

字段中，服务设计人员选择要向客户提供的服务。由于当前未指定过滤器规

则，因此，除该服务本身外，在预览面板中没有检索到和显示任何对象：

图 7-96 输入层次过滤器的基本详细信息
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SLM 方案

方案 4：创建层次过滤器
建立过滤器规则列表

服务设计人员现在已准备好开始添加过滤器规则。第一个规则是检索所有已用

的服务。服务设计人员单击“过滤器规则”列表下的“新建”按钮，以访问

“层次过滤器规则”对话框，然后单击“起始对象类型”字段旁边的“快速查

找”按钮：

图 7-97 搜索起始对象类型
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SLM 方案

方案 4：创建层次过滤器
服务设计人员从列表中选择“服务”：

图 7-98 选择“服务”作为起始对象类型

在此阶段，“服务”是唯一选项。添加了检索其它对象类型的过滤器规则后，

列表中将会包含那些对象的类型。
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SLM 方案

方案 4：创建层次过滤器
服务设计人员现在单击“关联属性”字段旁边的“快速查找”按钮。在“快速

查找”对话框中，服务设计人员选择“使用服务”关联属性：

图 7-99 选择“使用服务”作为关联属性

验证“层次过滤器规则”对话框的内容后，服务设计人员单击“确定”： 

图 7-100 确认已用的服务的过滤器规则
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SLM 方案

方案 4：创建层次过滤器
该过滤器规则将添加到“层次过滤器”表单的列表中，并且由该规则检索到

的已用的服务会自动显示在预览面板中：

图 7-101 由过滤器规则检索到的已用的服务

下一个要添加的过滤器规则是检索已用的配置项。再次选择“服务”作为起

始对象类型，并且选择“已用的配置项”作为关联属性：

图 7-102 确认已用的配置项的过滤器规则
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SLM 方案

方案 4：创建层次过滤器
该过滤器规则将添加到“层次过滤器”表单的列表中，并且由该规则检索到

的已用的配置项会自动显示在预览面板中：

图 7-103 由过滤器规则检索到的已用的服务和配置项
第 7 章 171



SLM 方案

方案 4：创建层次过滤器
下一个要添加的过滤器规则是检索使用“使用”关系类型的关联配置项。此

时，选择“配置项”作为起始对象类型，并且选择“关联配置项”作为关联

属性：

图 7-104 选择“关联配置项”作为起始对象类型

验证“层次过滤器规则”对话框的内容后，服务设计人员单击“确定”： 

图 7-105 确认用于检索关联配置项的过滤器规则
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SLM 方案

方案 4：创建层次过滤器
该过滤器规则将添加到“层次过滤器”表单的列表中，并且由该规则检索到

的关联配置项会自动显示在预览面板中。由于未指定关联类型（在此上下文

中，关联类型是“配置项关系类型”），因此，将检索所有关联配置项。

对于包含逆向关系类型的每个关系类型，连接关联配置项的连线是双向的。

为了区分这种情况，服务设计人员编辑过滤器规则以指定关联类型。

由过滤器规则检索到的关联配置项
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SLM 方案

方案 4：创建层次过滤器
首先，服务设计人员突出显示要编辑的规则，然后单击“编辑”按钮。在

“层次过滤器规则”对话框中，服务设计人员单击“关联类型”字段旁边的

“快速查找”按钮。

在打开的对话框中，服务设计人员选择“配置项关系”作为对象类型：

图 7-106 为“关联类型”选择“配置项关系”
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SLM 方案

方案 4：创建层次过滤器
服务设计人员现在选择“使用”配置项关系类型：

图 7-107 选择“使用”关联类型

验证“层次过滤器规则”对话框经过修改的内容后，服务设计人员单击

“确定”： 

图 7-108 确认对关联配置项的过滤器规则所做的更改
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SLM 方案

方案 4：创建层次过滤器
预览面板会自动更新，以仅显示类型为“使用”的配置项关系：

图 7-109 由经过编辑的过滤器规则检索到的关联配置项
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SLM 方案

方案 4：创建层次过滤器
服务设计人员现在添加过滤器规则，以检索关系类型为“运行于”的配置项： 

图 7-110 包含检索到的“运行于”配置项关系的层次
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SLM 方案

方案 4：创建层次过滤器
在本方案中，服务设计人员希望排除表示 HP/UX 基础结构的配置项，但是希

望包括表示 Windows 2000 基础结构的配置项。由于每个配置项都指定了一个

类别，因此，服务设计人员可以通过在过滤器规则中指定目标类别，对层次

过滤器进行必要的修改：

图 7-111 选择“WinInfra”作为目标类别

验证“层次过滤器规则”对话框经过修改的内容后，服务设计人员单击“确定”： 

图 7-112 确认指定了目标类别的过滤器规则
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SLM 方案

方案 4：创建层次过滤器
预览面板会自动更新，以删除表示 HP/UX 基础结构的配置项：

图 7-113 已完成的层次过滤器

服务设计人员保存并关闭该层次过滤器。服务经理现在可以使用该层次过滤

器来创建受监视服务。
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
方案 5：基于层次过滤器创建受监控服务

此方案说明基于第 164 页上的“方案 4：创建层次过滤器”中创建的层次过

滤器创建受监控服务的过程。该方案假设包含关联服务和配置项的 CMDB 已

存在。

指定 SLA 详细信息

服务经理的第一步工作是为已用的 SAP 网络服务创建新的 SAP 网络服务和服

务级别协议。此操作过程与第 137 页上的“方案 3：基于服务定义创建受监视

服务”中为 Web 服务使用的数据库服务创建服务和 SLA 类似。

服务经理现在为基于 SAP R/3 层次过滤器的 SAP/R3 服务创建新的 SLA：

图 7-114 为已用的服务创建服务级别协议
第 7 章180



SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理单击“服务级别”字段旁边的“快速查找”按钮，在“快速查找”

对话框中右击，然后选择用于创建新服务级别的命令：

图 7-115 将新服务级别与 SLA 相关联

新服务级别在表单中打开。服务经理指定基本详细信息：

图 7-116 指定新服务级别的基本详细信息 
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理保存新服务级别，然后在“快速查找”对话框中选择它：

图 7-117 选择新服务级别
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理继续在 SAP/R3 服务的服务级别协议表单中指定基本详细信息：

图 7-118 SAP/R3 服务的 SLA
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理单击关联服务列表下面的“新建”按钮：

图 7-119 将新服务与 SAP/R3 SLA 相关联
第 7 章184



SLM 方案

方案 5：基于层次过滤器创建受监控服务
新服务在表单中打开。服务经理将已与服务级别协议相关联的同一个层次过

滤器与该服务相关联，然后保存新服务。服务经理导航至“服务层次”选项

卡页时，从该过滤器继承的层次将会显示出来：

图 7-120 从层次过滤器继承的服务层次
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
将服务指标添加到层次中

服务经理现在考虑如何测量服务的符合性。创建服务时，基础结构可用性指标

会自动添加。服务经理决定添加类型为“SAP 响应类型”的一个附加 OVIS 指

标，因此，单击服务指标列表下面的“新建”按钮： 

图 7-121 将新服务指标添加到服务中
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
在服务指标表单中，服务经理单击“指标”字段旁边的“快速查找”按钮：

图 7-122 搜索指标

此时将打开“快速查找”对话框。在“对象类型”字段中，服务经理选择所

需的指标类型，然后从列表中选择测量 SAP 响应时间的指标。请注意，每个

指标不仅指定测量的类型，而且还指定指标数据值的源：

图 7-123 选择指标
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
所选的服务指标将添加到列表中。

图 7-124 新服务指标已添加到列表中
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
将配置项指标添加到层次中

服务经理现在考虑如何测量层次中的每个配置项。可以使用指标发现过程所

发现的任何指标。

服务经理决定使用 OVIS ICMP 可用性探测器来测量 SAP 负载平衡器。服务经

理单击层次中的 SAP 负载平衡器配置项，然后选择用于编辑它的命令。在配

置项表单中，服务经理导航至列出指标的选项卡页，然后单击“新建”按钮：

图 7-125 添加新配置项指标
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
在配置项指标表单中，服务经理单击“指标”字段旁边的“快速查找”按钮：

图 7-126 搜索指标

在打开的对话框中，服务经理选择所需的指标类型：

图 7-127 选择指标类型
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
在“快速查找”对话框中，服务经理选择测量可用性所需的指标。请注意，

每个指标不仅指定测量的类型，而且还指定指标数据值的源： 

图 7-128 为配置项选择指标

所选的指标将显示在配置项指标表单中。系统将基于所选的指标，自动为配置

项指标提供名称：

图 7-129 配置项指标表单中的所选指标
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理关闭该表单时，配置项指标会添加到配置项表单的列表中：

图 7-130 所选配置项指标已添加到列表中
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理重复该过程，以将配置项指标添加到 Win2k 配置项中：

图 7-131 配置项指标已添加到 Win2k 配置项中
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
将符合性目标添加到层次中

服务经理现在决定要添加哪些符合性目标。自动创建的基础结构可用性指标

为其符合性目标阈值预定义了运算符和值：

图 7-132 “符合性 SLO”表
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
对于测量 SAP 响应时间的指标，服务经理从“运算符”列的下拉列表中选择

目标运算符：

图 7-133 指定符合性目标阈值运算符
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理在表单元格中直接键入目标值：

图 7-134 指定符合性目标阈值
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
从指定测量 SAP 响应时间的指标开始，服务经理现在指定符合性冲突阈值和

符合性危险阈值。服务设计人员双击“符合性阈值”表中的相关单元格：

图 7-135 添加新的符合性冲突阈值
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理为符合性冲突阈值提供名称，并且决定保留默认冲突阈值 95% 不变：

图 7-136 指定符合性冲突阈值的基本详细信息
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理保存并关闭该表单后，冲突阈值信息将显示在“符合性阈值”表中。

下图显示了已完成的“符合性阈值”表：

图 7-137 已完成的“符合性阈值”表
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
将可用性目标添加到层次中

现在，服务经理决定要添加哪些可用性目标。“可用性 SLO”表最初显示一个

空的目标表：

图 7-138 “可用性 SLO”表

由于知道 OVIS ICMP 可用性指标将返回值 0 或 1，因此，服务经理决定为每个

指标定义指定的目标运算符为“大于或等于”，并且指定值为 1。指定运算符

“大于”和值 0.5 将具有同样效果。
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理从“运算符”列的下拉列表中选择所需的运算符： 

图 7-139 选择可用性目标运算符
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
服务经理在每个表单元格中键入所需的值：

图 7-140 指定目标值
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
下图显示了添加所有运算符和值后的可用性 SLO 表： 

图 7-141 已完成的“可用性 SLO”表

管理服务级别协议

最后，服务经理将服务级别协议置于 SLM 管理之下。有关如何执行此操作的

示例，请参阅第 161 页上的“管理服务级别协议”。
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SLM 方案

方案 5：基于层次过滤器创建受监控服务
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